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Introduction to NetBackup User’s Guide - UNIX
This guide describes how to use NetBackup for the UNIX platform to perform backups, 
archives, and restores. In this guide, VERITAS NetBackup is referred to as NetBackup.

The guide is intended for the system administrator and for the UNIX end user. It assumes 
a basic knowledge of UNIX commands and operations.

Organization of NetBackup User’s Guide - UNIX
The following are guidelines for using this document:

◆ “Introduction to NetBackup,”  provides an overview of NetBackup, describes how the 
end user operates NetBackup, and describes technical terms and concepts. Read this 
chapter to become familiar with the world of NetBackup.

◆ “Using the Java Interface,” explains how to use the NetBackup Java interface to 
perform backup, archive, and restore operations.

◆ “Using the Menu Interface,”  explains how to use the NetBackup menu interface, bp, 
to perform backup, archive, and restore operations.

◆ “Using the X-Windows Interface,”  explains how to use the graphical interface, xbp, 
to perform backup, archive and restore operations.

◆ “Reference Guide to xbp and bp,”  describes the various windows, screens, and 
menus associated with the xbp and bp user interface programs.

◆ Use the glossary for an explanation of terms used in this manual and in the 
NetBackup interfaces.

Related Documentation
The following documents provide related information. For a more detailed listing of 
NetBackup documents, refer to NetBackup Release Notes.

◆ NetBackup Installation Guide - PC Clients

Explains how to install NetBackup PC client software. The PC clients are Windows 
NT/2000, Windows 95, Windows 98, Macintosh, OS/2 Warp, and Novell NetWare. 
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Conventions
If you have a Unix server, refer to these documents:

◆ NetBackup Release Notes

Provides important information about NetBackup software, such as the platforms and 
operating systems that are supported and operating notes that may not be in the 
manuals or the online help.

◆ NetBackup Datacenter System Administrator’s Guide - UNIX

Explains how to configure and manage NetBackup Datacenter on a UNIX system.

◆ NetBackup BusinesServer System Administrator’s Guide - UNIX

Explains how to configure and manage NetBackup BusinesServer on a UNIX server.

◆ NetBackup Troubleshooting Guide - UNIX

Provides troubleshooting information for UNIX based NetBackup products.

If you have a Windows NT/2000 server, refer to these documents:

◆ NetBackup Release Notes

Provides important information about NetBackup software, such as the platforms and 
operating systems that are supported and operating notes that may not be in the 
manuals or the online help.

◆ NetBackup Datacenter System Administrator’s Guide - Windows NT/2000

Explains how to configure and manage NetBackup Datacenter on a Windows 
NT/2000 server system.

◆ NetBackup BusinesServer System Administrator’s Guide - Windows NT/2000

Explains how to configure and manage NetBackup BusinesServer on a Windows 
NT/2000 server.

◆ NetBackup Troubleshooting Guide - Windows NT/2000

Provides troubleshooting information for Windows NT/2000 based NetBackup 
products.

Conventions 
The following explains typographical and other conventions used in this guide.
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Conventions
Type Style

Notes and Cautions

Note This is a Note and is used to call attention to information that makes it easier to use 
the product or helps you to avoid problems.

Caution This is a Caution and is used to warn you about situations that can cause data 
loss.

Key Combinations

Some keyboard command sequences use two or more keys at the same time. For example, 
you may have to hold down the Ctrl key before you press another key. When this type of 
command is referenced, the keys are connected by plus signs. For example:

Press Ctrl+t

Command Usage

The following conventions are frequently used in the synopsis of command usage.

brackets [ ]

The enclosed command line component is optional.

Vertical bar or pipe (|)

Separates optional arguments from which the user can choose. For example, when a 
command has the following format:

Table 1. Typographic Conventions

Typeface Usage

Bold fixed width Input. For example, type cd to change directories.

Fixed width Paths, commands, filenames, or output. For example: The default installation 
directory is /opt/VRTSxx.

Italics Book titles, new terms, or used for emphasis. For example: Do not ignore cautions.

Sans serif (italics) Placeholder text or variables. For example: Replace filename with the name of your 
file.

Sans serif (no italics) Graphical user interface (GUI) objects, such as fields, menu choices, etc.

For example: Enter your password in the Password field.
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Getting Help
command arg1|arg2

the user can use either the arg1 or arg2 variable.

Getting Help
For updated information about this product, including system requirements, supported 
platforms, supported peripherals, and a list of current patches available from Technical 
Support, visit our web site:

http://www.veritas.com/

For product assistance, contact VERITAS Customer Support.

US and Canadian Customers: 1-800-342-0652

International Customers: +1 (650) 335-8555

VERITAS Customer Support can also be reached through electronic mail at:

support@veritas.com 
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Introduction to NetBackup
 1

NetBackup lets you back up, archive, and restore files, directories, or raw partitions that 
reside on your client system. In NetBackup terminology, the system that needs the backup 
or restore is the client (or agent). The system that manages the storage and retrieval of the 
backup data is called the NetBackup server.
1



User-Directed Operations
User-Directed Operations
User-directed operations are NetBackup operations the user can perform from the client. 
These operations can be performed without administrator intervention or  logging into 
the NetBackup server.

User-directed operations include:

◆ Back up files, directories or raw partitions that reside on your local disk. A backup 
operation saves the data to a storage device on the NetBackup server.

◆ Archive files and directories that reside on your local disk. An archive operation saves 
the selected files and directories to a storage device on the NetBackup server and then 
deletes them from your local disk.

◆ Restore previously backed up or archived files, directories, or raw partitions to either 
the location from which they were backed up or to another location. You select what 
you want to restore and NetBackup automatically restores it to the disk.

After you start a user-directed operation, the server manages storage and retrieval of data. 
All file transfers occur in the background so there is no long wait for the operation to 
complete before regaining control of your terminal.

User Interfaces
NetBackup provides four user interfaces:

◆ Java interface

◆ Menu interface

◆ X-Windows graphical interface

◆ Command line interface

You can perform user-directed operations through any of these interfaces, but the Java 
and menu interfaces are the one that you will probably use most often:

◆ The Java graphical interface can be used on supported Solaris or HP-UX systems and 
on systems that have the NetBackup Java Windows Display Console installed. Refer 
to “Using the Java Interface” on page 9  for on using the Java interface.

◆ The character-based menu interface is used on virtually any terminal that can connect 
to a client system. The bp command starts the menu interface program. Refer to 
“Using the Menu Interface” on page 47 for details on using the bp menu interface. 

◆ The X-Windows-based graphical interface is used on any X terminal or workstation 
with an X server program compatible with X11.R4 or later. The xbp command starts 
the graphical interface program. Refer to “Using the X-Windows Interface” on 
page 69 for details on using the xbp graphical interface.
2 NetBackup User’s Guide - UNIX



Progress Logs and Mail Notifications
◆ The command line interface lets you perform backup, archive, restore, and list 
operations by entering individual commands at the shell prompt. 

The following commands are available in the command line interface. 

bp

bparchive

bpbackup

bplist

bprestore

xbp

For descriptions of commands see the man pages. To view the man pages, enter, for 
example: 

man bp

Note If the man pages are not installed on your system, contact your system 
administrator. 

Information on the commands is also included in the NetBackup System Administrator’s 
Guide - UNIX.

The Java, x-windows, and menu interfaces have all the options necessary to perform and 
monitor user-directed operations. An important feature of these interfaces is their built-in 
ability to browse for and select files and directories:

◆ During a backup or archive, you can browse the file system on your client to select 
files and directories.

◆ During a restore, you can browse the backup history for your client to select files and 
directories that you have previously saved. It is also possible to browse the backup 
history for other clients if the NetBackup administrator gives you the necessary 
permissions.

Progress Logs and Mail Notifications
NetBackup progress logs provide information on the progress of a NetBackup operation. 
These logs also indicate the success and failure of a NetBackup operation. For each 
user-directed operation, NetBackup can be configured to create a separate progress log 
file. You can delete the log files when they are no longer needed. For more details on 
creating log files, refer to “Checking Progress of Operations” on page 92 for xbp or 
“Checking Progress of Operations” on page 67 for bp. For more details on log files for 
jbp, refer to “Viewing the Progress of Backups and Restores” on page 29.
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Backup and Archive Windows
The NetBackup server can be configured to deliver the client user email notifications on 
the status of the client user’s NetBackup operations. Refer to the NetBackup System 
Administrator’s Guide - UNIX or the NetBackup System Administrator’s Guide - Windows 
NT/2000 for details on configuring the server for email notifications.

Backup and Archive Windows
NetBackup can be configured to allow user-directed backups or archives to occur only 
during specific time periods, usually referred to as windows. For example, if your window 
is from 8 am to 6 pm, you will not be able to back up or archive at other times. The 
NetBackup administrator defines these windows during server configuration. 

Note The backup and archive windows do not affect user-directed restores. You can 
perform a restore at any time.

Automatic Backups
The NetBackup administrator can configure NetBackup to perform automatic full and 
incremental backups of your client system. These backups occur unattended and under 
control of the NetBackup server. If carefully scheduled, the automatic backups will meet 
most of the backup requirements for your client. NetBackup can also be configured to 
send mail on the success or failure of automatic backups to the administrator of your 
client system.

For more information on automatic backups and other administrator directed activities, 
refer to the NetBackup System Administrator’s Guide - UNIX or the NetBackup System 
Administrator’s Guide - Windows NT/2000.

Exclude and Include Lists
The NetBackup system administrator configures the exclude and include lists for your 
client. 

The NetBackup exclude list contains a list of files and directories that will not be included 
in scheduled backups. Files and directories in the exclude list can still be backed up 
manually through the user interface.

In some cases, the system administrator may create an exclude list for a specific class or a 
class and schedule combination. The master server will use a single exclude list when 
performing a scheduled backup for all clients in the specified class or class and schedule 
combination. If, however, an individual client finds that a file or directory must be 
included in a scheduled backup, then an include file list can be created on the client.
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Alternate Client Restores
The NetBackup include list contains a list of files and directories that will be included in a 
scheduled backup. This is also useful if, for example, you want to exclude an entire 
directory except for one file.

The NetBackup System Administrator’s Guide - UNIX or the NetBackup System 
Administrator’s Guide - Windows NT/2000 provide instructions for creating the exclude and 
include lists.

Alternate Client Restores
With the necessary permissions and configuration, users can browse the NetBackup 
database for files backed up by another NetBackup client and restore files to their own 
computer.

System administrators can direct restores to the client that originally backed up the files or 
to another (alternate) client. This type of restore can be performed on any server and is 
called a server directed restore. The NetBackup administrator can direct file or raw 
partition restores to any client.

Read This Before Using NetBackup
Read the following before performing any user operations with NetBackup. 

Cautions and Notes to Observe When Using NetBackup

◆ When performing backups and archives, remember that if a file is only a symbolic link 
to another file, NetBackup backs up or archives only the link, not the file itself. This 
eliminates multiple backups of a file when more than one directory contains a 
symbolic link to it. It also means you must be certain to back up or archive the source 
file.

◆ On a Hewlett Packard system, do not attempt to restore a file in a CDF directory if the 
CDF does not already exist. If you do, the directory is created without the directory 
mode bits necessary for it to be recognized as a CDF. The correct procedure is to 
restore the CDF itself thus restoring the files it contains. To restore only missing files 
in a CDF, ensure that you specify to not overwrite existing files. 

◆ The maximum path length that you can specify for a file is 1023 characters.

◆ The overwrite option is ignored during raw partition restores. The device file must 
exist and the disk partition is overwritten whether this option is set or not. 
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Read This Before Using NetBackup
Questions to Ask Your Administrator

During configuration, the administrator configures NetBackup to meet the backup and 
archiving requirements of your site. The following are some questions you should ask the 
administrator about your configuration before you use NetBackup. Knowing the answers 
to these questions can help you to avoid problems later:

◆ Which files and directories will NetBackup include in automatic backups of your 
client? The list that the administrator configures may not include everything on your 
local disk. If there are additional files that you want backed up, you can either ask the 
administrator to add them to the file list for automatic backups or back them up 
yourself.

◆ When do the automatic backups occur? By knowing the schedules, you can recognize 
when you must perform your own backups to preserve critical data.

◆ When are user-directed backups and archives permitted for your client? During 
configuration, the administrator determines when you can perform backup and 
archive operations. For example, if they are allowed between 8 am and 4 pm, you will 
be unable to perform a backup or archive at 6 pm.

◆ What is the retention period for your data? It is difficult to recover expired backups. 
Therefore, ensure that the retention time is long enough to suit your needs.

◆ (NetBackup DataCenter users) Can you back up, archive, and restore NFS mounted 
files? NetBackup allows this but your specific configuration may not. Remember that 
when you archive NFS files, you remove them from the system on which they reside.

◆ Does your configuration permit backups and archives of entire file paths even if they 
cross file systems? For example, if the backups and archives for your workstation are 
configured to cross file systems, specifying / (root) backs up the entire disk. 
Otherwise, specifying / backs up only the files and directories that are in the / file 
system and excludes files in other file systems.

◆ How do you restore files that were backed up or archived by another client? 
Normally, NetBackup allows you to restore files only for the original client. The 
administrator can override this if necessary.

◆ Is the NetBackup configuration set up to provide you with mail notifications on the 
results of your user-directed operations? These mail notifications can eliminate the 
need for you to monitor the progress logs. NetBackup can also send mail on the 
success or failure of automatic backups to the administrator of your client system.

File Permissions Required By NetBackup

You need UNIX read permission to back up a file and UNIX write permission to archive a 
file (since the archive operation removes the file from the disk).
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Read This Before Using NetBackup
Note During a backup or archive, NetBackup stores only the user ID and group ID that 
are assigned to the files. NetBackup does not store the user ID and group ID of the 
person performing the backup. For example, assume a user uuu and group ggg own 
a file and the root user backs it up. Regardless of who restores it, the restored file 
still shows user ID = uuu and group ID = ggg.

Listing and restoring files and directories require the following UNIX permissions:

◆ To list or restore files in a directory owned by someone else, you must have read and 
execute permission for the directory and all directories leading to it. 

◆ To restore a file to its original location, you must have write access to the file (if the file 
exists), or to the directory (if the file does not exist).

The following table shows how NetBackup restores files in various situations (for 
example, if a copy of the file or directory already exists).

Table 2. File Permissions

Type of Restore Attempted Results

Restore a file that already 
exists and overwrite the 
existing file.

If you are a root user, NetBackup restores the file and sets file 
ownership to the same owner as the backup image.

If you are not a root user, NetBackup restores the file only if you 
have write access to it. In a case where the file is read only, but you 
have write access to the parent directory, NetBackup removes the 
file and restores the backup image with you as the owner.

Restore a file that already 
exists and not overwrite the 
existing file.

For both root and nonroot users, NetBackup does not restore the 
file and places a message in the progress log.

Restore a file that doesn’t 
exist.

If you are a root user, NetBackup restores the file and sets file 
ownership to the same owner as the backup.

If you are a nonroot user, the file is created with you as the owner 
and restored only if permissions on the parent directory allow it.

Restore a file when a directory 
exists with the same name as 
the file.

For both root and nonroot users, NetBackup places an error 
message in the progress log and does not restore the file or remove 
the directory. This occurs regardless of whether you elect to 
overwrite existing files.

Restore a directory when a file 
exists with the same name as 
the directory.

NetBackup restores the directory and removes the file, providing 
that permissions allow it and you elect to overwrite existing files. 
Ownerships are set as follows.

If you are a root user, NetBackup sets ownership of the directory to 
that of the original owner. 

If you are a nonroot user, the user name under which you are doing 
the restore is assigned ownership.
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Read This Before Using NetBackup
Restore a file in a directory 
that does not exist.

NetBackup creates the directory with the user name and group of 
the user doing the restore and uses the mask bits 022 to set the 
mode of the directory. The file is then restored in the same manner 
as one that does not exist (see above).

Table 2. File Permissions

Type of Restore Attempted Results
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Using the Java Interface
 2

The NetBackup Java user interface (jbpSA) provides a graphical-user-interface through 
which users can perform backups, archives, and restores. The interface can be started and 
run on the following systems (see Figure 1):

◆ Supported Solaris or HP-UX systems.

◆ Windows NT/2000, 98, or 95 systems that have the NetBackup Java Windows Display 
Console installed. The display console makes it possible to use the Java interface 
when a Solaris or HP-UX system is not available.

Topics covered in this chapter:

◆ Starting the Java Interface

◆ Adjusting the Time Zone

◆ Helpful Hints on Locating and Marking Files

◆ Performing Backups and Archives

◆ Performing Restores

◆ Viewing the Progress of Backups and Restores

◆ Advanced Restore Procedures

◆ Tips and Troubleshooting
9



Figure 1. NetBackup Java User Interface

 

UNIX NetBackup Client
(Solaris or HP-UX)

UNIX NetBackup Client
(other than Solaris or HP-UX)

shark

tiger

Backup, Archive, Restore 
interface

To start the interface on shark, log 
in on shark and execute jbpSA.

In the Login dialog box that appears when 
starting the interface program, specify the client 
where you want to perform the backup, archive, 
or restore (shark or tiger in this example).

bear

Backup, Archive, Restore 
interface

To start the interface on bear, choose 
NetBackup - Java on host on the 
Start->Program->NetBackup 

Windows NT/2000, 98, 95 
system with NetBackup 
Java Windows Display 
Console software installed.
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Starting the Java Interface
Starting the Java Interface

From a UNIX Platform

1. Log in on the UNIX NetBackup computer where you are going to start the Backup, 
Archive, and Restore interface.

2. Start the Backup, Archive, and Restore interface by executing:

/usr/openv/netbackup/bin/jbpSA &

For additional usage information enter: jbpSA -h.

The Login dialog box appears.

3. Type the name of the client where you want to perform the backup, archive, or 
restore.

You must have a valid  user account on that client, and have access to that client. 

4. Specify the user name.

◆ For UNIX clients, type the client name.

◆ For Windows clients, type the domain and client name, using the format 
domain\username, for example:

ourcompany\gla

5. Specify the password.

6. Click Login.

The Backup, Archive, and Restore - NetBackup window appears.

Setting Up Your Window Manager for the Java Interface

Always set your window manager so windows become active only when you click inside 
the windows. Do not enable auto focus, which is when windows become active if you just 
move the mouse pointer over them. The NetBackup-Java interfaces do not run properly 
with auto focus enabled. The following are general instructions for correctly setting up the 
focus.

CDE (Common Desktop Environment)

The following explains how to set up a CDE (Common Desktop Environment) window 
manager, which is the preferred window manager for NetBackup-Java applications.
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Starting the Java Interface
1. On the front panel in the CDE window, click the Style Manager control icon.

The Style Manager toolbar appears.

2. On the Style Manager toolbar, click the Window control icon.

The Style Manager - Window dialog box appears.

3. In the Style Manager-Window dialog box, click the Click In Window To Make Active 
button.

4. Click OK.

5. Click OK when asked to Restart the Workspace Manager.

Motif

When using the Motif window manager, set the Mwm*keyboardFocusPolicy X 
resource as follows:

Mwm*keyboardFocusPolicy:explicit

From a Windows Platform

You can also use the Java interface from a Windows platform, if you have installed the 
Windows Display Console. 

1. Click Programs on the Start menu.

2. On the Programs menu, point to NetBackup and then click NetBackup - Java on host 
on the submenu.

The Login dialog box appears. Host is the default NetBackup client where you 
perform user operations. 

To perform user operations on another client, type its name in the NetBackup host 
field. 

3. Type your user name and password and click Login.

4. When login is complete, the NetBackup Administration - Java window appears.

5. Click the Backup, Archive, and Restore button to begin. The Backup, Archive, and 
Restore - NetBackup window appears with the Restore Files tab selected.
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Adjusting the Time Zone
Adjusting the Time Zone
NetBackup gives you the ability to adjust the time zone settings for the current session 
(and for all future sessions, if you have administrative capabilities). 

There are two situations where it would be necessary to change the time zone settings:

◆ You reside in a time zone that is not correctly translated by the underlying Java code 
in NetBackup. The Middle European time zone, for example, is interpreted as Middle 
Eastern Time. You will need to adjust the time zone settings so that backups receive 
the correct datetime stamps.

◆ You administer sites that are in different time zones. You may need to adjust the time 
zone settings before restoring files.

Example

Assume, for example:

◆ You have received a request to restore a backup made on March 3, 2000 at 12:00 a.m. 
Eastern Standard Time (EST), which is 5 hours behind Greenwich Mean Time (GMT). 

◆ You reside in the Pacific Standard time zone (PST), which is 8 hours behind GMT.

If you do not change your time zone settings to EST and search for backups created on 
March 3, 2000, you will not be able to find the backup. According to your time zone 
settings (PST), the backup was created at 9:00 p.m. on March 2, 2000.

▼ To Adjust the Time Zone Settings

1. On the View menu, select Adjust Application Timezone.

Note If you launched jbp by executing jnbSA, the Adjust Application Timezone option is 
available from the Configure menu in the NetBackup Administration - Java 
window.

2. Adjust the time to reflect how many hours/minutes the server’s time zone is behind 
or ahead of Greenwich Mean Time.

3. To use daylight savings time, select Use daylight savings time.

4. Indicate when Daylight Savings Time should begin.

a. Select the method you wish to use for indicating when Daylight Savings Time 
should begin.

◆ To have DST begin on a specific date, select Absolute date and indicate the 
desired month and day.
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Adjusting the Time Zone
◆ To have DST begin on the first occurrence of a day in a month, select First day 
of week in month and indicate the desired day of the week and the month.

◆ To have DST begin on the first occurrence of a day in a month and after a 
specific date, select First day of week in month after date and indicate the 
desired day of the week and the month and day.

◆ To have DST begin on the last occurrence of a day in a month, select Last day 
of week in month and indicate the desired day of the week and the month.

◆ To have DST begin on the last occurrence of a day in a month and before a 
specific date, select Last day of week in month after date and indicate the 
desired day of the week and the month and day.

b. Select the appropriate Day of week, Month, Day, and Time.

5. As you did in step 4, indicate when Daylight Savings Time should end.

6. If you have administrative capabilities and wish to have the time zone settings 
applied to the current session and all future sessions, select Save as default timezone.

7. Click OK.

To have DST begin/end: Enter this:

April 5

First Monday in April

First Monday after April 5

Last Thursday in April

Last Thursday before April 30
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Helpful Hints on Locating and Marking Files
Helpful Hints on Locating and Marking Files
This section explains what you need to know to navigate in the directory trees and filter 
files on the Backup Files and Restore Files tabs and how to mark files and folders for 
backup or restore operations. 

Navigating in the Directory Trees

To display the contents of a folder:

◆ Click on the folder name in the left pane. The right pane will show the contents of that 
folder.

◆ Folders that have subfolders have a plus sign (+) to the left of the folder. To display 
the subfolders, click on the plus sign or double-click on the folder. The left pane will 
display the subfolders within that folder. 

◆ On the Restore Files tab, you can also display the contents of a folder by typing the 
directory path in the Browse directory box and pressing Enter.

◆ To collapse a folder, click on the minus sign (-) to the left of the folder or double-click 
on the folder.

File Icons

The following icons are used to indicate the file types displayed in the Contents of 
Selected Directory Pane.

Description Icon

Represents a directory.

Represents a Java file.

Represents a Java class file.

Represents a program file.

Represents an HTML file.

Represents a UNIX link.

Represents a read-only file.
16 NetBackup User’s Guide - UNIX



Helpful Hints on Locating and Marking Files
Filtering Files

You can filter the files and folders shown in the Contents of Selected Directory pane. To 
display only filenames beginning with “sys,” for example, type sys* in the Filename filter 
field and click Refresh. To display only files with the “txt” extension, fill in *.txt. This 
filter is case-insensitive.

When jbpSA starts, * appears in the Filename filter box; this will display all files.

Sorting Columns

The columns in the Contents of Selected Directory pane can be sorted by clicking on the 
column header. To sort by Modified date, for example, click on the Modified column 
header. Click on the column header again to sort in descending order.

Marking Files and Folders

◆ To mark a file for backup or restore, select the checkbox to left of a file or right-click on 
the file and select Mark.

◆ To select multiple contiguous files, click the checkbox to left of the file you wish to 
mark, hold down the Shift key, and click the checkbox to left of the last file in the 
group you wish to mark. To select non-contiguous files, hold down the Ctrl key as 
you make your selections.

Right-click and select Mark to mark the files you selected.

◆ To mark a folder for backup or restore, select the checkbox to the left of a folder. A 
check mark will appear in the box. A slash mark in the box indicates only some of the 
files or subfolders within that folder are marked.

Marking a folder automatically marks all its files and subfolders.

◆ To mark all of the files and folders shown in the right pane, click the Mark All button. 

Represents a text file.

Represents a bitmap, gif, or icon file.

Represents a file that doesn’t have an icon associated with it.

Description Icon
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If more than one version of a file or folder is displayed (because the file or folder was 
backed up more than once during the date range selected), NetBackup will mark only 
the most recent version.

Unmarking Files and Folders

◆ To unmark a file, clear the checkbox to the left of the file or right-click on the file and 
select Unmark.

◆ To unmark a folder, and all its files and subfolders marked within that folder, clear the 
checkbox to the left of the folder.

◆ To unmark all of the files and folders shown in the Contents of Selected Directory 
pane, click the Unmark All button.
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Performing Backups and Archives
This section will step you through a simple backup procedure. The process would be the 
same if you choose to archive, except that the files you choose will be deleted after they 
are backed up.

This process assumes that you have already started the NetBackup Java console and are 
looking at the Backup, Archive, and Restore - NetBackup window as described in 
“Starting the Java Interface” on page 11.

1. Click on the Backup Files tab.

2. If necessary, change the NetBackup master server that will perform the backup.

If there is more than one master server to which you can send your backups and 
archives, ensure that you are connected to the correct one. Ask your NetBackup 
administrator if you have questions about which master server to use.

Normally, you will not have to switch master servers unless, for some reason, the 
administrator has temporarily moved the NetBackup backups (for example, because 
of a problem on the original master server). If the change becomes permanent, the 
administrator should change your default to reflect the other server.

a. Click the browse button next to the NetBackup server box.

b. Select the desired server from the list.

c. Click OK.

If you typed an invalid name, or if your client does not belong to a NetBackup 
class on that server, you will get an error. If this occurs, see your system 
administrator for assistance.
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3. Mark the file or files to back up. In this example it is sample.txt.

You can filter the files and folders shown in the Contents of Selected Directory pane. 
Click Refresh once you have entered the filter criteria. For more information, see 
“Filtering Files” on page 17.

4. Start the Backup operation by clicking Backup.

5. The Backup Files dialog box will appear.

6. To associate a keyword phrase with the backup or archive, type a keyword or phrase 
into the Keyword phrase to associate with this backup or archive box. You can then 
search for that keyword or phrase if you wish to restore this specific backup or 
archive.
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In this example, the keyword phrase test will be used.

◆ To delete the file after it has been backed up, select Archive files.

◆ To remove a file from the list of files to back up, select the file and click Remove 
from list.

7. Click Start Backup to begin the backup operation.

Note The NetBackup operation may take a few minutes to complete. 
Chapter 2, Using the Java Interface 21



Performing Backups and Archives
8. You will be prompted to view the status of the backup operation. Click Yes to open the 
Task Progress tab.

 

The Task Progress window allows you to view the progress report of a NetBackup 
operation. For more information, see “Viewing the Progress of Backups and Restores” 
on page 29. 
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Performing Restores
This section will step you through a simple restore process, using the same file that was 
backed up as an example in the previous section. It assumes that the NetBackup browser 
has already been started as described in “Starting the Java Interface” on page 11.

Notes on Performing Restores

◆ Before performing a restore, ensure that the correct or desired time zone settings have 
been set. See “Adjusting the Time Zone” on page 13.

◆ If there are any links in the path you are searching, NetBackup, by default, resolves 
the links so the path points to the actual file or directory. If you do not want to resolve 
links, deselect Use Actual Path If Browse Directory is Linked on the View menu before 
starting your search. See “Resolving Links” on page 42 for more information.

◆ NetBackup restores files according to the original file pathname. If the files you are 
restoring already exist, you must have the proper file permissions in order to 
overwrite the existing files with the backed-up files. See “File Permissions Required 
By NetBackup” on page 6 for an explanation of how NetBackup restores files in 
various situations.

Tips on Locating Files and Folders to Restore

Once you have filled in the information to narrow your search, click Refresh to update the 
right pane.

◆ If you know the exact directory you wish to browse, type the path to that directory in 
the Browse directory box. This will speed up your request.

◆ You can filter the files and folders shown in the Contents of Selected Directory pane. 
Click Refresh once you have entered the filter criteria. For more information, see 
“Filtering Files” on page 17.

◆ If you indicated a keyword phrase when you performed a backup, you can use that 
keyword or phrase to locate that backup by entering the keyword phrase in the 
Keyword phrase to search for field.
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Performing a Basic Restore

1. Click on the Restore Files tab.

2. Change the NetBackup master server if necessary. 

If there is more than one master server that can back up this client, ensure that you are 
connected to the one that performed the backup you are trying to restore. If you 
attempt to restore from another master server, the files will not be found. Ask your 
NetBackup administrator if you have questions about which master server to use.

a. Click the browse button next to the NetBackup server box.

b. Select the desired server from the list.

c. Click OK.
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If you typed an invalid name, or if your client does not belong to a NetBackup 
class on that server, you get will an error. If this occurs, see your system 
administrator for assistance.

3. From the Type of Backup drop-down list, select the type of restore to perform.

◆ To restore a backup, select Normal Backup.

◆ To restore an archive, select Archive.

◆ To restore a true image, select True image. For more information on restoring a 
true-image backup, see “Restoring a True Image of a Folder” on page 40.

4. Select the folder or file to restore. 

You can filter the files and folders shown in the Contents of Selected Directory pane. 
Click Refresh once you have entered the filter criteria. For more information, see 
“Filtering Files” on page 17.

In this example we will use the keyword phrase feature to restore the sample.txt 
that was backed up in “Performing Backups and Archives” on page 19.

a. Type test in the Keyword phrase to search for box.

b. In the Browse directory box, type the path to backed up file. In this case the path is 
/home/gla1.

c. Click Refresh.
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d. In the right pane, mark the checkbox to the left of the sample.txt file.

5. Click Restore.
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6. The Restore Files dialog will appear.

7. By default, files will be restored to their original location. 

See “Restoring Files to an Alternate Path” on page 36 for information on restoring all 
files to an alternate destination or restoring individual files to multiple destinations.

8. Select Overwrite existing files. By default, NetBackup does not overwrite files.

9. To skip over file systems mounted in the selected directories, select Restore 
directories without crossing mount points. Clear this checkbox to restore file systems 
that are mounted in the selected directories.

Note Mount points inside will get restored whether or not the Restore directories without 
crossing mount points checkbox is selected.

10. Click Start Restore to begin the restore operation.
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11. You will be prompted to view the status of the restore operation. Click Yes to open the 
Task Progress tab.

The Task Progress tab allows you to view the progress of a NetBackup operation. For 
more information, see “Viewing the Progress of Backups and Restores” on page 29.
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Viewing the Progress of Backups and Restores

1. Click the Task Progress tab.

2. Click Update Task List to refresh the list of tasks being performed.

3. Click on the task that you want to check the progress of.

The lower pane will reflect the progress of the item selected in the top pane.

4. To automatically refresh the results of the tasks:

a. Click Auto Refresh.

b. Select a refresh interval. The default setting is 10 seconds. A smaller interval may 
negatively affect the server performance. 
Chapter 2, Using the Java Interface 29



Viewing the Progress of Backups and Restores
5. By default the progress file is displayed in an abbreviated form. If you wish to view 
the entire contents of the progress file, click Full Contents.

The NetBackup operation is finished when the Status changes to Successful. If the task 
failed, review the Results of task log and check with your NetBackup system 
administrator.
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Advanced Restore Procedures
The following procedures provide detailed explanations for performing advanced 
restores.

Searching for Files to Restore

Occasionally, you might want to restore a file or directory, but you may not remember 
where it is, or was, located. The Find feature allows you to specify a file or directory name 
and search for it.

1. Click on the Restore Files tab.

2. Click . The Find Files window appears.

3. In the File or Directory Name box, enter the name of the directory or file you wish to 
search for.

You can use the wildcard symbol (*) to search for a directory or file if you are unsure 
of the exact name or wish to display directories or files with similar names.

4. If you want to perform a case-insensitive search, check the box in front of that option. 
The default is case-sensitive, meaning the file name must match exactly as it was 
entered. 

For example, if you enter sample.txt and select case-sensitive, NetBackup will only 
find files that use that exact capitalization. The files Sample.txt and SAMPLE.TXT 
would not appear in the results.

5. Click Find Now. NetBackup will display all backups of the directory or file you 
entered.
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Note It may take a few minutes for the list of files to refresh. 

6. To select a file or folder, click on the checkbox to the left of the file or folder. 

7. Click OK to return to the Restore dialog. The files or folders you selected are now 
marked to be restored.

8. To start the restore operation, click Restore.

Selecting Specific Backup Dates to Restore

By default, the NetBackup Restore window shows the files and folders that were backed 
up since the last full backup. The default range will satisfy the majority of your needs to 
restore files but there will be times when you must restore a file that was not backed up 
during the default time period. For example, a file that was deleted prior to the last full 
backup will not appear in the default display. In order to locate and backup up this file 
you would need to change the date range.

If the client belongs to more than one class, the starting date defaults to the last full 
backup that occurred first. For example, assume that: 1) a client belongs to ClassW1 and 
ClassW2, 2) Full backups occur for both of these classes, 3) ClassW1’s most recent full 
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backup occurred on June 16 and ClassW2’s most recent full backup occurred on June 24. 
NetBackup will display those files and folders that have been backed up since the 
ClassW1 full backup on June 16.

Note If you are searching a specific range of dates, selecting a directory will not 
necessarily restore all the files and subdirectories that were backed up during the 
last full backup. The Contents of Selected Directory pane will show only the files 
and subdirectories that were backed up during the range of dates indicated. If a file 
or folder was backed up more than once during the date range selected, multiple 
copies of that file or folder will appear in the right pane.

Setting the Date Range

There are three ways you can set the date range, by manually selecting the dates in the All 
backups between fields, by selecting the dates via the Calendar, or by selecting the dates 
via the Backup History.

Setting the Date Manually in the All backups between fields

1. On the Restore Files tab, choose All backups between.

2. To change the start date and time, select the part of the date or time you wish to 
change. Use the spinner controls to indicate an earlier or later date or time. 

To change the day, for example, select the day. Click the top arrow to indicate the next 
day, the bottom arrow to indicate the previous day.

3. Modify the end date in the same way.

4. Click Refresh to refresh the list of files shown.

Setting the Date Via the Calendar

1. From the View menu, choose Use Calendar to set date.

2. On the Restore Files tab, choose All backups between.

3. Click on the Calendar button .
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4. Select the desired start date on the Calendar.

◆ To change the month, select the desired month from the drop-down list in the 
upper-left corner of the dialog.

◆ To change the year, select the desired year from the drop-down list in the 
upper-left corner of the dialog.

◆ To change the time, select the part of the time you wish to change. Use the spinner 
controls to indicate an earlier or later time. 

5. Click OK.

6. Modify the end date in the same way.

7. Click Refresh to refresh the list of files shown.

Setting the Date Via the Backup History

1. From the View menu, choose Use Backup History to set date.

2. On the Restore Files tab, choose All backups between.

3. Click on the Backup History button .
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4. Select the desired backup image or images from the list.

Tip To select multiple contiguous backup images, select the first backup image, hold 
down the Shift key, and click the last image in the group you wish to select. 

5. Click OK.

6. Click Refresh to refresh the list of files shown.

Restoring an Earlier Version of a Folder

Note The following procedure will restore all files that were backed up during the range 
of backup dates that you search for files to restore. This includes files that were 
deleted from your online directory after they were backed up. If you do not want 
the deleted files, use the procedure described in “Restoring a True Image of a 
Folder” on page 40.

1. Click on the Restore Files tab.

2. Set the start date and end date that includes the desired version of the directory.

3. Click Refresh.
Chapter 2, Using the Java Interface 35



Advanced Restore Procedures
4. Select the folder you wish to restore from the Directory Structure pane and the check 
the right pane to see if it shows the files you need.

Note By default, NetBackup restores the directory to its original location. To restore to an 
alternate location, see “Restoring Files to an Alternate Path.” 

5. Click Restore to begin the restore operation.

Restoring Files to an Alternate Path

In some instances, you may want to restore files to a backup or path other than the one 
from which they were backed up. This is called an alternate path restore.

Restoring Everything to a Different Location

1. Click on the Restore Files tab.

2. Select the files or folders you wish to restore.

Note You will be able to restore files and folders differently depending on how you mark 
the files and folders for a restore. If you wish to back up an entire folder and all its 
contents to the same alternate location, mark the folder in the left pane. If you wish 
to back up the files in a folder to different locations, mark the files in the right pane.

3. Click Restore.

4. Select Restore everything to a different location. 
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5. In the Destination box, enter the alternate directory to which you want to restore the 
files or folders.

6. Select Overwrite existing files.

7. Select Restore directories without crossing mount points to skip over file systems 
mounted in the selected directories. Clear the Restore directories without crossing 
mount points checkbox to restore file systems that are mounted in the selected 
directories.

8. If restoring files that are links, choose whether to update those link pathnames.

◆ Select Rename hard links to rename the hard link pathnames. Clear the Rename 
hard links checkbox if you do not want to rename the hard link pathname.

◆ Select Rename soft links to rename the soft (symbolic) link pathnames. Clear the 
Rename soft links checkbox if you do not want to rename the soft link pathname.

Note If you are restoring system files to a disk other than the current system disk and 
plan on using the other disk as the system disk with the original file paths when the 
restore is completed, we suggest that you select the Rename hard links checkbox 
and clear the Rename soft links checkbox. This will let you use the other disk and 
have the correct file paths.
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9. Click Start Restore.

Restoring Files and Directories to Different Locations

1. Click on the Restore Files tab.

2. Select the files or folders you wish to restore.

Note You will be able to restore files and folders differently depending on how you mark 
the files and folders for a restore. If you wish to back up an entire folder and all its 
contents to the same alternate location, mark the folder in the left pane. If you wish 
to back up the files in a folder to different locations, mark the files in the right pane.

3. Click Restore.

4. Select Restore individual directories and files to different locations.

5. To change the destination for a file or folder, right-click on the file. You can select 
multiple files and folders using Ctrl + click or Shift + click (see “Marking Files and 
Folders” on page 17).
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a. From the shortcut menu, select one of the following:

◆ Select Change Selected Destinations to indicate a different destination for the 
file or files selected.

◆ Select Change All Destinations to apply a single destination location to all the 
files.

◆ Select Add Destination to restore a subset of files (e.g., a subdirectory) to a 
directory other than the alternate directory specified for other files.

◆ Select Remove Destinations to have the selected file or files restored to their 
original locations.

b. If you have selected Change All Destinations or Add Destination, you can also 
specify which directory to apply the alternate destination to. Assume you had 
chosen to restore all files to /home/gla1/temp, for example, but wanted the 
subdirectory /home/gla1/sample/ installed to a location other than 
/home/gla1/temp. In the Type of Backup box, you would enter 
/home/gla1/sample/. That folder would then be restored to a different 
alternate directory.

c. In the Destination box, enter the destination for the file or files.

d. Click OK.

6. Select Overwrite existing files.

7. Select Restore directories without crossing mount points to skip over file systems 
mounted in the selected directories. Clear the Restore directories without crossing 
mount points checkbox to restore file systems that are mounted in the selected 
directories. 

8. If restoring files that are links, choose whether to update those link pathnames.

◆ Select Rename hard links to rename the hard link pathnames. Clear the Rename 
hard links checkbox if you do not want to rename the hard link pathname.

◆ Select Rename soft links to rename the soft (symbolic) link pathnames. Clear the 
Rename soft links checkbox if you do not want to rename the soft link pathname.

Note If you are restoring system files to a disk other than the current system disk and 
plan on using the other disk as the system disk with the original file paths when the 
restore is completed, we suggest that you select the Rename hard links checkbox 
and clear the Rename soft links checkbox. This will let you use the other disk and 
have the correct file paths.
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9. Click Start Restore.

Restoring a True Image of a Folder

A true-image restore of a directory, by default, restores the directory so its contents are 
exactly what they were at the time of the most recent automatic full or incremental 
backup. Files deleted prior to the specified backup are not restored. 

A true image restore is the best choice if, for example, you have recently cleaned up a 
directory by deleting unwanted files and now want to restore the latest version without 
having to repeat your cleanup. It is also possible to restore the true image of an earlier 
version of a directory.

Example of a True Image Restore

To illustrate the concept of a true image restore, consider the following table, which shows 
the contents of a directory named:  

home/abc/doc

during a series of backups performed between 12/01/95 and 12/04/95.

Assume that you are going to restore the most recent version of the directory.

◆ If you perform a standard restore, NetBackup will restore all files and subdirectories 
that were backed up during the time period from 12/01/95 (last full backup) through 
12/04/95. 

file1
file2

file1

file2

dirA/fileA

dirB/fileB

file3

file1

file2

dirA/fileA

-

-

file1 file1 file1

file2 file2 file2

dirA/fileA dirA/fileA

-

-

-

-

-

-

dirC/fileC

file4 file4

-

-

Day
Type of Backup

12/01/95
(Full)

12/02/95
(Incr)

12/03/95
(Incr)

12/04/95
(User Back)

12/04/95
(Incr)
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dirA/fileA
dirB/fileB
file3
dirC/fileC
file4

◆ If you restore a true image backup, NetBackup restores only the files and directories 
that existed at the time of the incremental backup on 12/04/95. 

file1
file2
file4

NetBackup does not restore anything deleted prior to the 12/04/95 incremental 
backup. 

Notice that the restored directory does not include the dirA and dirC subdirectories, 
even though they were backed up on 12/04/95 with a user-directed backup. 
NetBackup did not restore these directories because they did not exist at the time of 
the incremental backup that was the reference for the true image restore.

True Image Restore and Overwriting

If you are overwriting the directory you are restoring, NetBackup does not delete files that 
are currently in the directory but not in the true image restore backups. 

Using the previous example, if you had created a file5 after the incremental backup 
occurred on 12/04/95, but before doing the restore, then the contents of the directory after 
the restore would have been:

file1
file2
file4
file5 (this is the new file that is not in any of the backups)

True-Image Restore Procedure

Note You can restore a true image of a folder only if the NetBackup class that is backing 
up your files is configured to collect true-image restore information prior to backup. 
If in doubt, ask your NetBackup administrator.

Note NetBackup does not allow a true-image restore that is based on the time of a 
user-directed operation. However, NetBackup does use the data from a 
user-directed operation when performing a true-image restore if the user backup is 
more recent than the latest automatic full or incremental backup.
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1. Click on the Restore Files tab.

2. Make sure that your root directory is selected.

3. Select True image from the Type of Backup drop-down list. 

4. Click Refresh to refresh the list of backups available for restore.

5. Select the folder that you want to restore.

Since you are restoring a directory in its entirety, as it existed on a specific date, 
NetBackup only allows you to select one version of the directory. For the same reason, 
the Mark All button is also disabled.

Note If NetBackup does not find any directories, check the range of dates and path. If 
these settings are correct and no directories are found, check with your 
administrator to see if the NetBackup class that is backing up your files and 
directories is configured to collect true-image restore information.

6. Click Restore. By default, the folder is restored to its original location.

Resolving Links

When searching for files to restore, you can choose whether to have NetBackup resolve 
links that may exist in the search path. If you resolve links, NetBackup automatically 
changes the path so it points to the actual file or directory. Otherwise, NetBackup uses the 
path you type in.

Note jbpSA resolves links by default, unless you deselect Use Actual Path If Browse 
Directory is Linked on the View menu before starting your search.

Note NetBackup does not resolve links if you use wildcard characters in the search 
directory path.

It is usually best to resolve links. There are exceptions such as the following:

◆ If you backed up a file that was not a link and, since then, the file path was linked to a 
different directory. 

For example, assume you backed up /home/bjm and this directory is now a link to 
/home2/bjm . If you resolve links during the restore, NetBackup will not find the file 
because it searches for /home2/bjm and /home/bjm was the path you backed up.
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◆ If you are restoring a file to your machine that was backed up by another client. There 
will be a problem if the path exists as a link on your machine, but not on the other 
client.

For example, assume that the path /usr/openv/ is linked to /opt/openv on the local 
machine, but not on the other client machine. If you select Use Actual Path If Browse 
Directory is Linked, jbp will look for /opt/openv on the other client, even though the 
path doesn’t exist on that client.

1. Backup File

/home/bjm

2. Link File

/home/bjm In home2/bjm

3. Restore File

If links are resolved:

User specifies /home/bjm, NetBackup 
resolves it to /home2/bjm and cannot find it.

If links are not resolved:

User specifies /home/bjm, NetBackup 
does not resolve it and is able to restore it from tape.

/home/bjm

/home/bjm
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Tips and Troubleshooting

Right Mouse Button Does Not Invoke Pop-up Menu

On a Solaris x86 with a two-button mouse, right-clicking will not invoke the pop-up 
menu.

This problem affects alternate path restores, specifically restoring files to multiple 
locations, because the destination location can only be changed by selecting a command 
from the pop-up menu.

▼ To invoke the pop-up menu

1. Press and hold the right mouse button.

2. Press the Ctrl key.

3. Release the right mouse button.

4. Release the Ctrl key.

Differentiating Between Different Backups on the Same Day

By default the Restore Files tab only shows the latest file entries since the last full backup. 
This is designed to reduce the number of files displayed. 

Sometimes it is useful to see all the available backups, perhaps to restore the version from 
three days ago. In this instance click on the All backups between option on the Restore 
Files tab and set the appropriate date (see “Selecting Specific Backup Dates to Restore” on 
page 32). 

If a file or folder was backed up more than once during the date range selected, multiple 
entries will be shown for that file or folder. You can narrow the list by entering a smaller 
date range or by changing the time.

Restoring a File Not Initially Shown on the List

If a file is not initially shown in the list of files that can be restore, it is likely that the file 
was backed up by the user, and not in the last full backup. Select All backups between and 
then enter a new start date. Click Refresh to see if the file appears. 
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Unmarking a File Takes a Long Time

Sometimes when you unmark a file it may take a long time before control of the 
application is returned to you. This can happen when you have marked an entire 
directory (in the Directory Structure pane) and then you unmark a single file in the 
directory.

Selecting an Invalid Client Type Causes Problems

Although it is possible to change the “Type of client,” in most situations the default client 
type is appropriate and should not be changed. 

Symptoms of an invalid client type are: 

◆ All attempts to backup files fail. The following error message appears in the Task 
Progress tab for each failed backup: 

no active classes in the configuration database are of the 
correct client type.

◆ Existing backups do not appear in the Directory Structure and Contents of Selected 
Directory panes. 

If you suspect a problem is caused by an invalid client type setting, change the Type of 
Client to the value appropriate for your operating environment (“Standard” for UNIX). If 
problems persist, ask your NetBackup administrator for advice on setting client type to 
match your organization's NetBackup configuration. 
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Using the Menu Interface
 3

This chapter explains how to use the NetBackup menu interface program, bp, to perform 
NetBackup operations. The menu interface is character-based (curses) so you can use it at 
any terminal (or terminal emulation window) for which you have a termcap or 
terminfo definition. You can also use the menu interface (xbp) or the Java interface 
(jbp) on any terminal with the proper prerequisites. The menu interface has the 
functionality of xbp and jbp but with a menu-driven presentation.

The purpose of this chapter is to provide step-by-step procedures for using the menu 
interface. If you need information about specific screens or menu options within the 
interface, refer to Chapter 5, “Reference Guide to xbp and bp.” 

The areas covered here are:

◆ Starting the Menu Interface

◆ Performing Backups or Archives

◆ Performing Restores

◆ Resolving Links

◆ Checking Progress of Operations
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Starting the Menu Interface
Starting the Menu Interface
Start the menu interface program by typing the /usr/openv/netbackup/bin/bp 
command.

When bp starts, the Main Menu appears on your screen as shown. 
 

The name of your client and NetBackup master server are shown at the top of the menu. If 
more than one master server is available to your client, you can use the M (Change Master 
Server) option on the Backup Menu menu to select another server.

Performing Backups or Archives
The following procedure explains how to perform a backup of files, directories, or raw 
partitions or to archive files and directories. The main difference between backups and 
archives is that an archive deletes the designated directories and files from your disk after 
successfully backing them up.

1. Type the following command line: 

/usr/openv/netbackup/bin/bp

The Main Menu will appear.
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Performing Backups or Archives
2. Select the B (Backup) option. The Backup Menu will appear.
 

Refer to “Backup Menu” on page 124 for details on this menu.

Note The following menu items do not apply to BusinesServer: Backup SAP DB, Backup 
DB2 DB, and Backup SQL-BackTrack DB.

Check the name in the Master Server field. This field shows the name of the server to 
which NetBackup will send your backups. When you start the bp interface program, 
this field is set to the default for your client. 

You should not have to switch master servers unless the administrator has moved the 
backups. If the change becomes permanent, the administrator should change your 
default to reflect the other master server.

To change master servers, choose the M (Change Master Server) option and type the 
name of the other server. If you type an invalid name or your client does not belong to 
a class on that server, you will get an error.
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3. Select the B (Backup Files and Directories) option. The Backup of Files and Directories 
menu will appear.

4. Check the Path field at the top of the menu to see if it is set to the directory where you 
want to start the search for the desired files. At start-up, NetBackup sets Path to your 
current working directory.

In this example, we are going to backup the release_notes.txt file located in the 
/usr/openv/netbackup/ directory. 

a. To change the path, choose the P (Change Path) option from the Backup of Files 
and Directories menu. The following will appear.

b. Type the following for the New File Path.

/usr/openv/netbackup/ 

c. Press Enter to return to the Backup of Files and Directories menu.

5. Check that the Start Date and End Date fields include the last-modified dates of the 
files you want to back up.

a. To change the range of dates, select the D (Change Date Range) option from the 
Backup of Files and Directories menu. The following will appear.

b. Type the new start date.
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c. Press Enter. The following will appear.

d. Type the new end date.

e. Press Enter to return to the Backup of Files and Directories menu.

6. Type the keyword phrase you want to use to identify the backup. In this example, we 
will use the keyword bptest.

a. Select the K (Change Keyword Phrase) option from the Backup of Files and 
Directories menu. The following will appear.

b. Type the keyword bptest.

c. Press Enter to return to the Backup of Files and Directories menu.

7. Select the files and directories you want to back up.

a. Select the from the Backup of Files and Directories menu. The following will 
appear.

b. Use the menu options at the bottom of the screen to browse the file system and 
select the desired files and directories.
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c. Choose the (S)elect option to select the release_notes.txt file. An asterisk (*) 
will appear to the left of the selected file.

If you select a directory, all files and directories below the selected directory will 
be selected. An asterisk (*) will appear to the left of the selected directory.

d. Select the (O)k to return to the Backup of Files and Directories menu. 

8. Preview the files and directories you have selected to back up.

a. Select the E (Edit/View Selected Files) option from the Backup of Files and 
Directories menu. The following will appear.

This screen lists your selections and lets you make changes. 

b. Make sure the release_notes.txt file appears in the list. 

c. Select the (O)k to return to the Backup of Files and Directories menu.

9. Start the backup operation.
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Note You can return to the Backup of Files and Directories menu at any time up to 
starting the operation by pressing the Escape key.

a. Select the I (Initiate Backup) option from the Backup of Files and Directories 
menu. The following will appear.

b. Type Y to create a log file and write to this file as the operation progresses. The 
following will appear.

If you do not want logging, type N to start the operation and go to step d. 

c. Press Enter to accept the default (shown in parentheses), or type a new path and 
press Enter. The operation begins when you press Enter. The following will 
appear.

d. Press any key to return to the Backup of Files and Directories menu.

10. Select the Q (Quit Menu) to return to the Main Menu.

Performing Restores
NetBackup restores files according to the original file pathname. If current files have the 
same names as backed-up files, you can pick whether to overwrite the current files (file 
permissions must allow overwriting). See “File Permissions Required By NetBackup” on 
page 6 for an explanation of how NetBackup restores files in various situations.

Note When restoring NetWare backups, set the directory depth to a minimum of 6 to 
ensure that the backup image is displayed.
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Note When restoring raw partitions, ensure that the partition is not mounted and not in 
use. Also ensure that the device file for the raw partition exists prior to the restore.

1. Type the following command line: 

/usr/openv/netbackup/bin/bp

The Main Menu will appear.
 

2. Choose the R (Restore) option from the Main Menu. The Restore Menu appears.
 

Refer to “Restore Menu” on page 128 for details on this menu.

Note The following menu items do not apply to BusinesServer: Restore From Auspex 
FasBack Backups, Restore From SQL-BackTrack DB Backups, Restore From SAP DB 
Backups, and Restore From DB2 DB Backups.

If your site supports more than one master server and you want to browse or restore 
files from another server, check the Master Server field at the top of the screen. When 
you start the bp interface program, the Master Server field shows the default for your 
client.
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To browse a backup on another master server, choose the M (Change Master Server) 
option and type the name of the other server. If you type an invalid name or your 
client does not belong to a class on that server, you get an error.

3. Select the B (Restore Files and Directories from Backups) option. The Restore Backups 
menu will appear.

4. View the backups for your client.

a. Choose the L (List Backup Images) option from the Restore Backups menu.

This screen shows the backups created. Notice that the keyword bptest, entered 
during the backup procedure described in “Performing Backups or Archives” on 
page 48, is displayed under the keyword column. For this example, we will be 
restoring from the backup with the bptest keyword.

b. Select (Q)uit to return to the Restore Backups menu.
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5. Check the Class Type field to see if it is set correctly.

a. To change the class type, select the Y (Change Client Type) option from the 
Restore Backups menu. 

 

The current class type appears in parenthesis.

Note The following class types do not apply to BusinesServer: Apollo-wbak, 
DataTools-SQL-BackTrack, Auspex-FastBackup, SAP, DB2, and FlashBackup.

b. Type the number for the new class type.

c. Press Enter to return to the Restore Backups menu.

6. Check the Path field at the top of the Restore Backups menu to see if it is set to the 
directory you want to start the search. At start-up, the current path is set to the 
directory from which you start the interface program. 

a. To change the path, select the P (Change Path) option. The following appears.

For this example, we will be changing the path to /usr/openv/netbackup.

b. Type the new file path.

/usr/openv/netbackup

The search begins in this directory and goes down the directory tree.

c. Press Enter to return to the Restore Backups menu.
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7. Check the Start Date and End Date fields to see if the range of dates includes the 
backup dates of the files you want to restore.

a. To change the range of dates, select the D (Change Date Range) option from the 
Restore Backups menu. The following will appear.

b. Type the new start date.

c. Press Enter. The following will appear.

d.  Type the new end date.

e. Press Enter to return to the Restore Backups menu.

8. Select the files and directories you want to restore.

a. Select the S (Select Files and Directories) option from the Restore Backups menu 
to search for files and directories that belong to the client and meet the path and 
date criteria. The following will appear.

If you are restoring an entire directory and the range of dates includes more than 
one backup date for files in the directory, NetBackup restores only the most-recent 
backups. To restore earlier versions, you can either:
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◆ Restore by file rather than by directory and select the files with the desired 
backup date. 

or 

◆ Return to step 7 and specify only the backup dates you desire. 

Here, you can restore the entire directory. Before proceeding, however, decide 
whether you want to overwrite all files in that directory with the earlier 
versions. If you do not want to overwrite existing files, you can restore the 
directory to an alternate path (see step 10 of this procedure).

You may also want to refer to “Shortcut Restore Procedures” on page 83 and 
“Restoring a True-Image of a Directory” on page 63.

b. Use the menu options at the bottom of this screen to move the display arrow to 
the line with the release_notes.txt file. 

c. Select the (S)elect to select the release_notes.txt file. An asterisk (*) will 
appear to the left of the selected file.

If you had selected a directory, all directories and files below the selected 
directory would have been implicitly selected. An asterisk (*) will appear to the 
left of the selected directory.

d. Select the (O)k to return to the Restore Backups menu.

9. Preview the files and directories you have selected to restore.
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a. Select the E (Edit/View Selected Files) option from the Restore Backups menu. 
The following will appear.

This screen lists your selections and lets you make changes.

b. Make sure the release_notes.txt file appears in the list. 

c. Select the (O)k to return to the Restore Backups menu.

10. Set up an alternate restore path. 

This is an optional step, used to restore files to a different path on the same client. In 
the following example, we will set up an alternate path restore from 
/usr/openv/netbackup to /usr/openv/netbackup/bin.

Note You cannot use NetBackup on the master server to restore a file to an alternate path 
on a NetBackup for Novell NetWare client. For those clients, you must perform the 
alternate path restore with the user interface on the NetWare client.

a. Choose the A (Specify Alternate Path) option from the Restore Backups menu. 
The following will appear.
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b. Press Enter. The following will appear.

c. Type the following path in the Enter Restore To field.

/usr/openv/netbackup/bin

d. Press Enter. The following will appear.

e. Type Y to use the indicated Restore From and Restore To paths on the next 
restore. The following will appear.

Type N to cancel the changes so the previous paths are still used.

f. Press any key to return to the Restore Backups menu.

11. Start the restore operation.

a. Type I (Initiate Restore) option from the Restore Backups menu. The following 
will appear.

Caution The overwrite option is ignored during raw partition restores. The device file 
must exist and the disk partition is overwritten whether this option is set or not.
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Performing Restores
b. Type Y to overwrite existing files. The following will appear.

Type N to if you do not want to overwrite existing files.

c. Type Y to create a log file and write to this file as the operation progresses. The 
following prompt will appear.

If you do not want logging, type N to start the operation and go to step d. 

d. Press Enter to accept the default (shown in parentheses), or type a new path and 
press Enter. The operation begins when you press Enter.

If you have previously selected an alternate-restore path (see step 10) the Use 
alternate path substitution? prompt appears:

To cancel the restore to alternate path, type N to start the restore operation and 
ignore the alternate path.

e. Type Y to use an alternate path. 
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f. Press Enter. The following will appear.

Note If you are restoring system files to a disk other than the current system disk and 
plan on using the other disk as the system disk with the original file paths when the 
restore is completed, we suggest that you specify Y (yes) on Rename Hard Links and 
N (no) on Rename Soft Links. This will allow you use the other disk and have the 
correct file paths.

If there are links in the path you are searching, NetBackup prompts you as to 
whether you want to resolve the links so the path points to the actual file or 
directory. If you do not want to resolve links, answer N (no) to the prompt. See 
“Resolving Links” on page 67 for more information.

g. Type N. The following will appear.
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h. Type N. The restore operation begins when you press N. The following will 
appear.

i. Press any key to return to the Restore Backups menu.

Restoring a True-Image of a Directory

A true-image restore will restore the contents of a directory to what it was at the time of a 
selected automatic full or incremental backup. See “Restoring a True Image of a Folder” 
on page 40 for an overview of true-image recovery. The concepts explained there for the 
Java interface also apply to the menu interface.

1. Select the D (Restore From True Image Backups) option from the Restore Menu. The 
Restore True Image Backups menu appears.

2. Select the D (Change Date Range) option from the Restore True Image Backups menu. 

◆ The default start date is the time of the last scheduled full backup of the class. Use 
the default unless you are restoring a version that existed before the latest full 
backup.
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◆ The default end date is the current date. If necessary, change this value to the 
reflect the date that you want to recover.

In this example, we are recovering the most recent version of the directory so we leave 
the date range at the defaults.

3. To view the backup list for true-image restore backups, choose the L (List TIR Backup 
Images) from the Restore True Image Backups menu.

4. To change the path, Select the P (Change Path) option from the Restore True Image 
Backups menu. 

Type the directory where you want to start searching for the desired backups. 
Searching begins in this directory and goes down the directory tree.

To search for a specific directory, type its complete path at the prompt. 

5. Select the S (Select Files and Directories) option from the Restore True Image Backups 
menu to search for directories that belong to the client and meet the path and date 
criteria. 

Individual files do not appear and cannot be selected because true-image restores are 
intended only for restoring entire directories. To list or select individual files in a 
true-image restore backup or range of backups, use the Restore Backups menu. 

A true-image restore will restore files that existed in the directory at the time of the 
incremental backup. Files that did not exist at the time of the incremental backup will 
not be restored.

Note If NetBackup cannot find any directories, check your range of dates, path, and 
directory depth. If these settings are correct and no directories are found, check 
with the administrator on the master server to see if the NetBackup class that is 
backing up your files and directories is configured to collect true-image restore 
information.

6. Select the files or directories you want to restore.

a. Use the menu options at the bottom of the screen to find and select the desired 
directory. 

b. When you are through selecting, select the (O)k to return to the Restore True 
Image Backups menu. 

7. Preview the files and directories you selected to restore.
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a. Select the E (Edit/View Selected Files) option from the Restore True Image 
Backups menu. 

b. Check that the directories you selected appear in the list.

c. Select the (O)k to return to the Restore True Image Backups menu.

8. If you want to restore to a directory other than the one from which the files were 
originally backed up, choose A (Specify Alternate Path) option from the Restore True 
Image Backups menu.

9. Type I (Initiate Restore) option to bring up the Initiate Restore screen.

10. Answer the prompts to start the restore. 

If you are overwriting the directory you are restoring, NetBackup does not delete files 
that are currently in the directory but not in the true-image restore backups. See “True 
Image Restore and Overwriting” on page 41.

Alternate Client Restore

Note You cannot use NetBackup on the master server to restore a file to an alternate path 
on a NetBackup for Novell NetWare client. For those clients, you must perform the 
alternate path restore with the user interface on the NetWare client.

1. Choose the R (Restore) option from the Main Menu. The Restore Menu appears.

2. Select the B (Restore Files and Directories from Backups) option. The Restore Backups 
menu will appear.

3. Change the source client.

a. Select the B (Change Source Client) option from the Restore Backups menu. The 
following appears.

The current client appears in parenthesis.

b. Type the client name from which you want to browse and restore files.

c. Press Enter to return to the Restore Backups menu.
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4. Change the destination client.

a. Select the T (Change Destination Client) from the Restore Backups menu. The 
following appears.

The current client appears in parenthesis.

b. Type the client name to which you want to restore files.

Note The destination client must be of the same class type as the source client.

c. Press Enter to return to the Restore Backups menu.

5. Check the class type for the source client and the destination client.

a. To change the class type, select the Y (Change Client Type) option from the 
Restore Backups menu. The current class type appears in parenthesis.

b. Type the class type for the source client and the destination client.

c. Press Enter to return to the Restore Backups menu.

6. Check the Path field at the top of the Restore Backups menu to see if it is set to the 
directory at which you want to start the search for the desired backups. 

a. To change the path, select the P (Change Path) option. 

b. Type the new file path.

c. Press Enter to return to the Restore Backups menu.

7. Select the files and directories you want to restore.

a. Select the S (Select Files and Directories) option from the Restore Backups menu 
to search for files and directories that belong to the source client and meet the 
path and date criteria. 

b. Use the menu options at the bottom of this screen to move the display arrow to 
the files or directories you want to restore to the destination client.
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c. Select the (S)elect to select the file or directory. An asterisk (*) will appear to the 
left of the selected file or directory.

If you select a directory, all directories and files below the selected directory will 
be implicitly selected. 

d. Select the (O)k to return to the Restore Backups menu.

8. Preview the files and directories you have selected to restore.

a. Select the E (Edit/View Selected Files) option from the Restore Backups menu. 
The resulting screen lists your selections and lets you make changes.

b. Review your selections. 

c. Select the (O)k option to return to the Restore Backups menu.

9. Type I (Initiate Restore) option to start the restore operation.

10. Follow the prompts. The restore operation begins when you press Enter.

Resolving Links

When searching for files to restore, you can choose whether to have NetBackup resolve 
links that may exist in the search path. If you resolve links, NetBackup automatically 
changes the path so it points to the actual file or directory. Otherwise, NetBackup uses the 
path you type in. For more information, see “Resolving Links” on page 42.

Note In bp, if links exist in the selected path, you get a prompt at the time you elect to 
browse the backups.

Note NetBackup does not resolve links if you use wildcard characters in the search 
directory path.

Checking Progress of Operations
When you start a NetBackup operation, you can have NetBackup create a log file in a 
directory of your choice and write to this file during the course of the operation. By 
default, NetBackup creates a log file in your home directory of the form:

bplog.bkup.n (for backups)

bplog.arch.n (for archives)
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bplog.rest.n (for restores)

Where n is a number that is unique for each file.

You can read log files by using the more command or a UNIX file editor. Delete the logs 
when you no longer need them. Since the log files can warn you of problems, it is usually 
best to read the log files before deleting them.

See “Interpreting Progress Logs” on page 93 for information on interpreting the logs.
68 NetBackup User’s Guide - UNIX



Using the X-Windows Interface
 4

This chapter explains how to use the graphical interface program, xbp, to perform 
NetBackup operations. This interface is X-Windows based and requires an X terminal or a 
workstation with an X server program compatible with release X11.R4 or later. The 
interface uses OSF and Motif conventions.

The purpose of this chapter is to provide step-by-step procedures for using the graphical 
interface. For information about specific windows or menu options within the interface, 
refer to Chapter 5, “Reference Guide to xbp and bp.” Refer also to the online help facility.

The areas covered here are as follows:

◆ Starting the Graphical Interface 

◆ Performing Backups and Archives

◆ Performing Restores

◆ Resolving Links

◆ Checking Progress of Operations

◆ Obtaining a List of Your Backups and Archives

◆ Finding and Selecting Files and Directories
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Starting the Graphical Interface

1. Ensure that your X terminal or workstation X server is named according to X 
conventions.

2. Set your DISPLAY environment variable to the appropriate value. 

The most convenient method is to define the DISPLAY variable with your login 
procedure.

The following example uses the setenv command after login to set up the display for 
an X terminal or server named orca:

setenv DISPLAY orca.user.abc.com:0

You can also use the -d option when you execute xbp command (see step 3). 

3. Start the graphical interface by typing xbp command as shown in the following 
examples. The variation you use depends upon whether your DISPLAY environment 
variable is already set:

◆ If the DISPLAY variable is set, type:

/usr/openv/netbackup/bin/xbp &

◆ If the DISPLAY variable is not set, use the -d option:

  /usr/openv/netbackup/bin/xbp -d orca.user.abc.com:0 &

The & character puts the program in background mode so your original window 
stays active and is available for other activities.
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When xbp starts, the xbp_main window appears on your screen. 

When you start xbp, the Browse File System (Backup or Archive) command from the File 
menu is selected by default. The Directory Structure pane and the Files pane show all 
directories and files in the directory specified in the Directory To Search box and the next 
two levels down. The Directory To Search box is set to the directory where you start xbp. 
You set the number of levels down in the Directory Depth box. 

Refer to “xbp_main Window” on page 102 for details on this window.
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Performing Backups and Archives
The following procedure explains how to perform a backup of files, directories, or raw 
partitions or to archive files and directories. The main difference between backups and 
archives is that an archive deletes the designated files and directories from your disk after 
successfully backing them up.

1. Change NetBackup master servers if necessary.

If there is more than one master server to which you can send your backups and 
archives, ensure that you are connected to the correct one. Ask your NetBackup 
administrator if you have questions about which master server to use.

Normally, you will not have to switch master servers unless, for some reason, the 
administrator has temporarily moved the NetBackup backups (for example, because 
of a problem on the original master server). If the change becomes permanent, the 
administrator should change your default to reflect the other server.

a. Click Configuration on the File menu. 

Refer to “File Menu” on page 103 for details on this menu.
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This opens the xbp_config dialog box.

The name of the current master server appears in the Server box. When you start 
xbp, the server is set to the default for your client. 

If you do not want to change the master server, click Cancel. If you want to 
change the master server, go to the next step.

b. Type the name of the other server in the Server box.

c. Click OK.

If you typed an invalid name, or if your client does not belong to a NetBackup 
class on that server, you get will an error. If this occurs, see your system 
administrator for assistance.

2. Find and select the desired files and directories.

If the desired files or directories are not currently displayed, find them by using the 
methods described under “Finding and Selecting Files and Directories” on page 94.

In this example we are going to select the release_notes.txt file.

a. Select the /usr/openv/netbackup directory in the Directory Structure pane.

When a directory is selected in the Directory Structure pane, all of the 
subdirectories and files listed in the Files pane are implicitly selected. These 
implicitly selected subdirectories and files will not appear highlighted in the Files 
pane.

(alternate client)
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b. Select release_notes.txt in the Files pane.

3. On the Backup menu, click Backup Selected Files and Directories. 

This opens the xbp_confirm dialog box. 
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Note If you click Archive Selected Files and Directories, NetBackup will back up the 
selected directory and all of its subdirectories, then delete the backed up directories 
from your system.

a. Review your selections in the xbp_confirm dialog box.

b. Choose whether to use the progress log file.

Select the Use Log File checkbox to create a log file in your home directory and 
write to this file as the operation progresses. The checkbox is selected when 
highlighted. 

The name of the log file appears in the Log Filename box. For information on 
checking the log, see “Checking Progress of Operations” on page 92.

c. Type a keyword in the Keyword phrase to associate with this backup box.

The phrase you type in the Keyword phrase to associate with this backup box will 
be the key for finding this backup during the restore process. In this example we 
will use the keyword test. You will use this keyword during the restore operation 
in the following section.

d. Click OK. This sends your backup request to the server. The main window will 
appear.

To return to the main window without starting the backup or archive, click 
Cancel.
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Performing Restores
The following topics explain how to restore files, directories, and raw partitions:

◆ Basic Restore Procedure - includes detailed instructions for restoring files.

◆ Shortcut Restore Procedures - abbreviated procedures for common operations.

◆ Advanced Restore Operations - information on performing true-image restores and 
alternate client restores.

Basic Restore Procedure

The following procedure is a detailed explanation of how to restore files, directories, and 
raw partitions to your client system.

Note When restoring NetWare backups, set the directory depth to a minimum of 6 to 
ensure that the backup image is displayed.

Note If you are restoring raw partitions, ensure that the partition is not mounted and not 
in use. Also ensure that the device file for the raw partition exists prior to the 
restore.

Note If you are restoring a directory, you may want to refer to “Shortcut Restore 
Procedures” on page 83 and “Restoring a True-Image of a Directory” on page 89.

1. Change NetBackup master servers if necessary. 

If there is more than one master server that can back up this client, ensure that you are 
connected to the one that performed the backup you are trying to restore. If you 
attempt to restore from another master server, the files will not be found. Ask your 
NetBackup administrator if you have questions about which master server to use.
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a. On the File menu, click Configuration. 

Refer to “File Menu” on page 103 for details on this menu.

This opens the xbp_config dialog box.

The name of the current master server appears in the Server box. When you start 
xbp, the server is set to the default for your client. 

If you do not want to change the master server, click Cancel. If you want to 
change the master server, go to the next step.

b. Type the name of the other server in the Server box.

c. Click OK.

(alternate client)
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If you typed an invalid name, or if your client does not belong to a NetBackup 
class on that server, you get will an error. If this occurs, see your system 
administrator for assistance.

2. Find the file and/or directory to restore.

a. On the File menu, click Browse Backups (Restore).
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A main window similar to the following will appear. 

Note If there are a large number of backups in your range of dates, a message box may 
appear to indicate that you cannot search for a specific path until you update the 
display. If this message appears, select Update Display from the Edit menu.

b. Specify the directory to search.

In this example, we are going to restore the release_notes.txt file backed up 
in “Performing Backups and Archives” on page 72. Type the following in the 
Directory To Search box:

/usr/openv/netbackup/

Note If there are any links in the path you are searching, NetBackup, by default, resolves 
the links so the path points to the actual file or directory. If you do not want to 
resolve links, click Do Not Resolve Links in Search Directory on the View menu 
before choosing a browse command from the File menu. See “Resolving Links” on 
page 91 for more information.

c. Specify the range of dates.
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When you go from backup mode to restore mode, NetBackup normally changes 
the starting date so that it defaults to the time of the last full backup. If you type in 
a specific date before changing modes, your specification is used (see “Selecting 
Specific Backup Dates to Restore” on page 87 for more details).

d. Specify the keyword phrase to search for.

In step c on page 75 of the “Performing Backups and Archives” section, you typed 
test as the keyword. So, in the Keyword phrase to associate with this backup 
box, type test.

e. Type *.txt in the Filename Filter box.

f. On the File menu, click Browse Backups (Restore).

A main window similar to the following will appear. 

g. Select the files and directories that you want to restore.

If the desired files or directories are not currently displayed, find them by using 
the methods described under “Finding and Selecting Files and Directories” on 
page 94. You can also specify another range of backups to search (see “Selecting 
Specific Backup Dates to Restore” on page 87).
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In the following figure, the /usr/openv/netbackup directory is selected in the 
Directory Structure pane. This implicitly selects all directories and files that are 
below /usr/openv/netbackup in the directory tree.

Note If you are selecting directories on the Files pane and then change your mind and 
unselect a directory, it is not unselected until you have selected either Clear 
Selection for Current Directory or Discard Selections for Previous Directories from 
the Edit menu. If you use Inspect All Selections from the Edit menu, you can see 
what is selected to be restored.

3. Start the restore.
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a. Click Restore Search Directory from the Restore menu. 

This opens the xbp_confirm dialog box.
 

b. Choose whether to use the progress log file.

Select the Use Log File checkbox to create a log file in your home directory and 
write to this file as the operation progresses. The checkbox is selected when 
highlighted. 

The name of the log file appears in the Log Filename box. For information on 
checking the log, see “Checking Progress of Operations” on page 92.

c. Select the Overwrite Existing Files checkbox. 

Note The disk partition is overwritten whether this option is set or not. The device file 
must exist. 

The Restore To Alternate Path checkbox and the Restore Directories Without 
Crossing Mount Points checkbox are enabled.

Note Mount points inside will get restored whether or not the Restore Directories 
Without Crossing Mount Points checkbox is selected.

NetBackup restores files according to the original file’s pathname. 

◆ Select the Overwrite Existing Files checkbox to overwrite an existing file with 
the restored file, providing file permissions allow it (see “File Permissions 
Required By NetBackup” on page 6). The checkbox is selected when 
highlighted.

◆ Clear the Overwrite Existing Files checkbox to prevent overwriting. The 
restore does not occur if a file with same pathname already exists.
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d. Review your selections.

4. Click OK. This will send your restore request to the server. The main window will 
appear.

To return to the main window without starting the restore, click Cancel.

Shortcut Restore Procedures

The following are abbreviated procedures for common types of restore operations.

Listing the Available Backups or Archives

If you are not sure of the dates when a file or directory was backed up, you can find out by 
browsing the backups. 

1. Type the directory that you want to restore in the Directory To Search box.

2. Leave the range of dates at the defaults (01/01/70 to the current date).

or

If you know the approximate range, type it in to narrow the range that will be 
displayed. Doing this speeds up your request.

3. On the File menu, choose the desired browse for restore option.

NetBackup updates the Directory Structure pane and the Files pane to show all 
backups or archives for the specified directory path and date range.

Because NetBackup has to obtain the file information from the backups on the master 
server, there can be a noticeable delay before the panes appear in the restore window.

Note If there are a large number of backups in the date range, you may be prompted to 
use Update Display from the Edit menu before NetBackup will search for the 
specific path.

Restoring the Most Recent Backup

The following explains how to restore the most recent backup that has occurred since the 
last full backup of your client.

1. Type the directory that you want to restore in the Directory To Search box.

2. On the File menu, click Browse Backups (Restore).
Chapter 4, Using the X-Windows Interface 83



Performing Restores
NetBackup updates the Directory Structure pane and the Files pane to show only the 
files and directories that were backed up from the time of the last full backup through 
the most recent backup (either incremental or user directed).

Since NetBackup has to obtain the file information from the backups on the master 
server, there can be a noticeable delay before the panes appear in the restore window.

Note By default, NetBackup restores the file to its original location. To restore to an 
alternate location, use Specify Alternate Path from the Restore menu before starting 
the restore.

3. Select the most recent backup of the file you want to restore.

Note If you are selecting directories on the Files pane and then change your mind and 
unselect a directory, it is not unselected until you have selected either Clear 
Selection for Current Directory or Discard Selections for Previous Directories from 
the Edit menu. If you use Inspect All Selections from the Edit menu, you can see 
what is selected to be restored.

4. On the Restore menu, click Restore Selected Files and Directories.

This starts the restore.

Restoring the Most Recent Version of a Directory

Note The following procedure will restore all files that existed in the directory from the 
time of the last full backup through the most recent backup. Files that were deleted 
from your online directory during that time period are also restored. If you do not 
want the files that were deleted from your online directory, proceed to “Restoring a 
True-Image of a Directory” on page 89.

You can restore the latest version of a directory with just one restore operation. The steps 
are the same as explained under “Restoring the Most Recent Backup” on page 83, except 
that here you must select a directory from the Directory Structure pane and use Restore 
Search Directory from the Restore menu. The restored directory has the last full backup of 
that directory, updated with all subsequent incremental and user backups.

There are two important things to remember when restoring a directory:
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1. The restored directory has only the files that are in the range of backups you selected 
with the start and end dates. Therefore, these dates must include the last full backup 
and all other backups through the latest date you are interested in. The best way to get 
the most recent backup is to use the date of the last full backup as start date and the 
current date as the end date (this is the default at the start of a browse).

2. It is usually best to select from the Directory Structure pane. Selecting from the Files 
pane restores only from the backup created at the backup date and time. If that 
backup is for an incremental, you will restore only the files in that incremental.

Advanced Restore Operations

The topics in this section explain how to perform more specialized restore operations. 
Also see the section on server directed restores in the NetBackup System Administrator’s 
Guide - UNIX or the NetBackup System Administrator’s Guide - Windows NT/2000.

Alternate Client Restore

The following explains how to restore a backup to an alternate client. Refer to “Basic 
Restore Procedure” on page 76 for a detailed restore procedure.

Note You cannot use NetBackup on the master server to restore a file to an alternate path 
on a NetBackup for Novell NetWare client. For those clients, you must perform the 
alternate path restore with the user interface on the NetWare client.

1. Change NetBackup master servers if necessary. 

a. From the File menu, click Configuration. 

This opens the xbp_config dialog box.

b. Type the name of the server in the Server box.

c. Click OK.

If you type an invalid name or your client does not belong to a NetBackup class 
on that server, you will get an error. See your system administrator for assistance.

2. From the Restore menu, click Specify Alternate Path.

This opens the xbp_altpath dialog box. 

a. Type the paths in the Restore From box and the Restore To box.

You can also use the Current Directory button to change paths to their default 
value, which is your current directory. 
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You cannot specify more than one alternate path. If you specify a path that does 
not exist, NetBackup creates it when restoring the file.

b. Before restoring files that are links, choose whether to update those link 
pathnames:

◆ Select the Rename Hard Links checkbox to rename the hard link pathnames. 
Clear the Rename Hard Links checkbox if you do not want to rename the hard 
link pathname.

◆ Select the Rename Soft Links checkbox to rename the soft link pathnames. 
Clear the Rename Soft Links checkbox if you do not want to rename the soft 
link pathname.

Checkboxes are selected when highlighted.

Note If you are restoring system files to a disk other than the current system disk and 
plan on using the other disk as the system disk with the original file paths when the 
restore is completed, we suggest that you select the Rename Hard Links checkbox 
and clear the Rename Soft Links checkbox. This will let you use the other disk and 
have the correct file paths.

c. Confirm or cancel the changes as follows:

◆ Click OK to use the paths indicated in the Restore From box and the Restore 
To box on the next restore.

or

◆ Click Cancel to cancel the changes so the previous paths are used.

3. On the File menu, click Browse Backups (Restore).

4. Specify the directory to search, the range of dates, the keyword phrase to search for, 
the directory depth, and the filename filter for the files you want to restore.

5. Find and select the files and directories that you want to restore.

6. Click the appropriate restore command on the Restore menu. 

This opens the xbp_confirm dialog box.

a. Select the Use Log File checkbox to create a log file in your home directory and 
write to this file as the operation progresses. 

b. Select the Overwrite Existing Files checkbox to overwrite an existing file with the 
restored file, providing file permissions allow it (see “File Permissions Required 
By NetBackup” on page 6). The checkbox is selected when highlighted.
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Clear the Overwrite Existing Files checkbox to prevent overwriting. The restore 
does not occur if a file with same pathname already exists.

c. Select the Restore To Alternate Path checkbox to confirm the restore to alternate 
path. The checkbox is selected when highlighted.

Clear the Restore To Alternate Path checkbox to cancel.

d. Select the Restore Directories Without Crossing Mount Points checkbox to skip 
over file systems mounted in the selected directories. The checkbox is selected 
when highlighted.

Clear the Restore Directories Without Crossing Mount Points checkbox to restore 
file systems that are mounted in the selected directories.

e. Review your selections.

f. Click OK to start to start the restore. The main window will appear.

To return to the main window without starting the restore, click Cancel.

Selecting Specific Backup Dates to Restore

By default, the NetBackup Restore window shows the files and folders that were backed 
up since the last full backup. The default range will satisfy the majority of your needs to 
restore files but there will be times when you must restore a file that was not backed up 
during the default time period. For example, a file that was deleted prior to the last full 
backup will not appear in the default display. In order to locate and backup up this file 
you would need to change the date range.

If the client belongs to more than one class, the starting date defaults to the last full 
backup that occurred first. For example, assume that: 1) a client belongs to ClassW1 and 
ClassW2, 2) Full backups occur for both of these classes, 3) ClassW1’s most recent full 
backup occurred on June 16 and ClassW2’s most recent full backup occurred on June 24. 
NetBackup will display those files and folders that have been backed up since the 
ClassW1 full backup on June 16.

If the default display does not show the desired files or directories:

1. Specify the range of backup dates that you believe contains the desired files and 
directories:

◆ Type the desired backup dates in the Range of Dates boxes.

or

◆ Select backups from the Backup Images pane.
Chapter 4, Using the X-Windows Interface 87



Performing Restores
The Range of Dates boxes will now contain the oldest and newest backup dates 
in the range of backups that you selected.

Note Narrow the date range as much as possible to speed up your search.

2. Position the pointer over any of the boxes and press Enter (or click Update Display on 
the Edit menu). 

NetBackup updates the Directory Structure pane and the Files pane to show only the 
files and directories that it finds in the range of backups that you specified. You can 
then select the backup you want and restore it.

Since NetBackup has to obtain the file information from the backups on the master 
server, there can be a noticeable delay before the panes appear in the restore window.

Restoring an Earlier Version of a Directory

Note The following procedure will restore all files that were backed up during the range 
of backup dates that you search for files to restore. This includes files that were 
deleted from your online directory after they were backed up. If you do not want 
the deleted files, use the procedure described in“Restoring a True-Image of a 
Directory” on page 89.

To restore a version of a directory that existed prior to the last full backup, select only the 
backups that include the desired version of the directory.

For example, assume that you want the /home/hrp/ directory as it existed on 10/5/95.

1. Browse all dates and examine the Files pane and the Backup Images pane.

In our example, we find that the following backups occurred. 

Backup Date and Time       Type of Backup
10/10/95  22:01:20  . . .  Full Backup  . . .
10/09/95  16:30:27  . . .  Incr Backup  . . .
10/02/95  18:05:41  . . .  Incr Backup  . . .
09/29/95  19:36:55  . . .  Incr Backup  . . .
09/25/95  18:06:15  . . .  Full Backup  . . .
09/20/95  16:06:21  . . .  Incr Backup  . . .
09/17/95  22:06:44  . . .  Full Backup  . . .

2. Set the start date and end date to include the required backups.

In this example, we set them as follows:

◆ Start date to 09/25/95. This the last full backup preceding 10/5/95. 
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◆ End date to 10/02/95. This is the incremental that includes the 10/5/95 version of 
the directory. The next date is 10/09/95, but that has changes we do not want.

3. Start another browse using Update Display from the Edit menu.

4. Select /home/hrp/ from the Directory Structure pane and the check the Files pane to 
see if it shows the files you need.

Note By default, NetBackup restores the directory to its original location. To restore to an 
alternate location, use Specify Alternate Path from the Restore menu before starting 
the restore.

Note If you are selecting directories on the Files pane and then change your mind and 
unselect a directory, it is not unselected until you have selected either Clear 
Selection for Current Directory or Discard Selections for Previous Directories from 
the Edit menu. If you use Inspect All Selections from the Edit menu, you can see 
what is selected to be restored.

5. On the Restore menu, click Restore Search Directory.

Restoring a True-Image of a Directory

A true-image restore of a directory, by default, restores the directory so its contents are 
exactly what they were at the time of the most recent automatic full or incremental 
backup. Files deleted prior to the specified backup are not restored. 

See “Restoring a True Image of a Folder” on page 40 for an overview of true-image 
recovery. The concepts explained there for the Java interface also apply to the menu 
interface.

True-Image Restore and Overwriting

If you are overwriting the directory you are restoring, NetBackup does not delete files that 
are currently in the directory but not in the true-image restore backups. An example is 
provided on page 41.

True-Image Restore Procedure

Note You can restore a true-image of a directory only if the NetBackup class that is 
backing up your files and directories is configured to collect true-image restore 
information. If you are in doubt, ask your NetBackup administrator.
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Note NetBackup does not allow a true-image restore that is based on the time of a 
user-directed operation. However, NetBackup does use the data from a 
user-directed operation when performing a true-image restore if the user backup is 
more recent than the latest automatic full or incremental backup.

Assume you are recovering /home/abc/doc/ as it existed on 12/04/95. Also assume 
you just started the xbp interface, so Browse File System (Backup or Archive) is selected 
with all settings at the defaults.

1. On the File menu, click Browse Backups (True Image Restore). 

The Directory Structure pane and the Files pane show the directories that are available 
for true-image restores. For our example, the default display shows the following.

Directory Structure                 Files
/home/abc

     doc                  12/04/95   20:05:22   doc/
       dirA               12/03/95   21:10:50   doc/
       dirB               12/02/95   20:10:34   doc/
                          12/01/95   20:15:34   doc/ 

Notice that the panes show only directories. Individual files do not appear because 
true-image restores are intended only for restoring entire directories. To list or select 
individual files, use the Browse Backups (Restore) mode. 

Note If NetBackup does not find any directories, check the range of dates, path, and 
directory depth. If these settings are correct and no directories are found, check 
with the administrator on the master server to see if the NetBackup class that is 
backing up your files and directories is configured to collect true image restore 
information.

2. Select the desired range of dates.

The default start date is the time of the last scheduled full backup of the class. Use the 
default unless you are restoring a version that existed before the latest full backup.

The default end date is the current date. If necessary, change this value to reflect the 
date that you want to recover.

In this example, we are recovering the most recent version of the directory so we leave 
the date range at the defaults. 

◆ Start date is 12/01/95

◆ End date is 12/04/95 
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3. If you changed the range of dates in step 2, click Update Display on the Edit menu to 
update the panes.

This step is unnecessary in our example, but is required if you change the range of 
dates.

4. From the Files pane, select the directory that you want to restore (NetBackup does not 
let you select from the Directory Structure pane for a true-image restore).

In our example, we select the 12/04/95 version of /home/abc/doc/ from the Files 
pane. 

Note If you are selecting directories on the Files pane and then change your mind and 
unselect a directory, it is not unselected until you have selected either Clear 
Selection for Current Directory or Discard Selections for Previous Directories from 
the Edit menu. If you use Inspect All Selections from the Edit menu, you can see 
what is selected to be restored.

Note By default, NetBackup restores the directory to its original location. To restore to an 
alternate location, use Specify Alternate Path from the Restore menu before starting 
the restore.

5. On the Restore menu, click Restore Selected Files and Directories (Restore Search 
Directory is not available for a true-image restore).

In our example, the restored directory has:

file1
file2
file4

This is the directory as it was at the time of the incremental backup that occurred on 
12/04/95. 

If you are overwriting the directory you are restoring, NetBackup does not delete files 
that are currently in the directory but not in the true-image restore backups.

Resolving Links

When searching for files to restore, you can choose whether to have NetBackup resolve 
links that may exist in the search path. If you resolve links, NetBackup automatically 
changes the path so it points to the actual file or directory. Otherwise, NetBackup uses the 
path you type in. For more information, see “Resolving Links” on page 42.

Note xbp resolves links by default, unless you click Do Not Resolve Links in Search 
Directory on the View menu before starting your search.
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Note NetBackup does not resolve links if you use wildcard characters in the search 
directory path.

Checking Progress of Operations
When you start a NetBackup operation, you can have NetBackup create a log file in a 
directory of your choice and write to this file during the course of the operation. By 
default, NetBackup creates a log file in your home directory of the form:

bplog.bkup.n (for backups)

bplog.arch.n (for archives)

bplog.rest.n (for restores)

Where n is a number that is unique for each file.

The following figure illustrates a xbp_progress dialog box.

This dialog box lists the progress log files that are in your home directory and lets you 
view them. (You can also read log files by using the more command or a UNIX file editor.)

The log information is in two scrollable panes:

◆ Log files in your $HOME directory (upper section of dialog)
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◆ Contents of selected log file (middle section of dialog)

View the contents of a log by selecting and highlighting its entry in the upper pane. The 
pane in the middle section displays any entries that NetBackup makes in the log file. 

Select the Automatic Refresh checkbox for automatic refresh. You can force a refresh by 
reselecting the same log file. The checkbox is selected when highlighted. 

When you are through checking progress, click Close to return to the xbp_main window.

Interpreting Progress Logs

The log messages notify you of important events that occur during the operation. These 
messages can have acronyms that specify the error level severity of an event. 

The error level acronyms are as follows:

Progress logs also list the media required for a NetBackup operation. For backups, the 
progress log lists the media IDs as NetBackup requests them during the course of the 
backup. For restores, the progress log begins by listing all the media IDs that NetBackup 
needs to recover the backups containing the files. If a backup or archive is split across 
more than one media ID, a restore log lists all the media but NetBackup uses only what it 
needs to restore the requested files.

Check the status at the end of the log to determine the final results of the NetBackup 
operation. If NetBackup was unable to backup or restore all the requested files, check the 
exit status that appears a few lines before the end of the log. This status will usually reveal 
the cause of the problem.

Mail Notifications

You can configure a bp.conf file in the client $HOME directory so the user will receive 
mail notifications on the results of user-directed operations. Refer to the NetBackup System 
Administrator’s Guide - UNIX or the NetBackup System Administrator’s Guide - Windows 
NT/2000 for instructions on configuring that file.

INF Informational message (no error occurred)

TRV Trivial error message

WRN Warning error message

ERR Error message

FTL Fatal error message
Chapter 4, Using the X-Windows Interface 93



Obtaining a List of Your Backups and Archives
Deleting Progress Log Files

To delete unnecessary log files from your directory, open the xbp_progress dialog box, 
select the log files and click Delete Log File. You can also delete logs manually by using 
system commands. Because they can warn you of problems, it is usually best to read the 
log files before deleting them.

Obtaining a List of Your Backups and Archives
You can use the bplist command to get a listing.

The bplist command lists backups and archives according to criteria, such as specific 
file or directory, client name, and range of dates. You can print a list by sending it to a file 
and then printing the file. 

For detailed instructions on using this command, see the man pages. Information on the 
commands is also included in the NetBackup System Administrator’s Guide - UNIX.

Finding and Selecting Files and Directories
This section explains what you need to know to find and select files and directories. See 
Chapter 5” for more information on menus, text boxes, and other items mentioned in the 
following descriptions.

Navigating in the Directory Tree

Go Lower in the Directory Tree

To go lower in the directory tree:

◆ Double click on a lower level directory in the Directory Structure pane.

or 

◆ Click the directory and press Enter.

The Directory To Search box now shows the selected directory and the Directory Structure 
pane and the Files pane are updated accordingly.

You can also type the directory path in the Directory To Search box and press Enter. This 
has the same effect as clicking the directory in the Directory Structure pane.
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Go Higher in the Directory Tree

To go higher in the directory tree, type the path of the higher level directory in the 
Directory To Search box and press Enter. Pressing Enter updates the display (another way 
to update the display is to click Update Display on the Edit menu).

Show the Contents of a Directory

To see files that are in a directory, click the directory in the Directory Structure pane. The 
contents appear in the Files pane.

Filter by Date

To show only files that were modified or backed up within a certain date range, set the 
Range of Dates boxes to include those dates and press Enter to update the display:

◆ For a backup, specify the last modified dates.

◆ For a restore, specify backup dates.

You could set the range of dates to show only those modified before or after a certain date. 
For example, you could pick only today’s files. 

Filter by File Name

To show only specific file names that are under the Directory To Search box, use the 
Filename Filter box. This makes selection easier if you want only specific files but there are 
many files under Directory To Search box. For example, you can find files ending in .doc 
by using the filter expression *.doc. When xbp starts, the filter is set to * and displays 
everything.

Change the Number of Directory Levels Displayed

To set the number of directory levels displayed, change the number in the Directory Depth 
box (default is 2).

Selecting for Backup, Archive, or Restore

To select a file or directory in the Files pane, click its name to highlight it. Clear a file or 
directory by clicking it again:

◆ To select everything in the current directory, click Select All in Current Directory on the 
Edit menu. Clear an individual file or directory by clicking it again.

◆ To clear all selections for the current directory, click Clear Selection for Current 
Directory on the Edit menu.
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Caution If you click on Select All in Current Directory on the Edit menu to perform a 
NetBackup operation, and the directory you select is large, the operation can be 
very slow. Instead of selecting everything, consider using Restore Search 
Directory, Backup Search Directory or Archive Search Directory.

During a backup, selecting a directory from the Files pane implicitly selects everything in 
the directory, including subdirectories and files. During a restore, selecting a directory in 
the Files pane restores only the files and subdirectories that are in the backups that 
occurred during the indicated range of dates.

You select from the Directory Structure pane in the same manner as from the Files pane, 
except that you can select only one item at a time. When you select a directory to highlight 
it, the Files pane shows the directories and files in this directory.

When you are through selecting, start the NetBackup operation by choosing the 
appropriate option from the Backup menu or Restore menu. This opens the xbp_confirm 
dialog box and adds your selections to that dialog. If you made previous selections and 
opened the xbp_confirm dialog box but did not confirm your selections (and therefore did 
not perform the actual NetBackup operation), xbp remembers them and keeps them in 
the xbp_confirm dialog box. This lets you return to the main window and make changes 
before confirming.

To clear all selections from the xbp_confirm dialog box, click Discard Selections for 
Previous Directories on the Edit menu. 

Previewing Selected Files

You can view the list of selected files at any time by clicking Inspect All Selections on the 
Edit menu. This opens a dialog box similar to xbp_confirm, except that it does not have an 
OK button.

Change Directory Structure Pane and the Files Pane Format

You can change the following aspects of how directories and files appear in the panes.

Show Directory Structure

To indent items in the Directory Structure pane to show the directory hierarchy, click 
Indented tree structure on the View menu. This is the default. To view the full pathnames 
of directories in the Directory Structure pane, click Full pathnames on the View menu. 

Show Number of Directory Levels Shown

To modify the number of subdirectory levels that appear in the Directory Structure pane 
and the Files pane, modify the Directory Depth box.
96 NetBackup User’s Guide - UNIX



Finding and Selecting Files and Directories
Show Most Recent or All Backups

For a restore, you can choose from the View menu to display either All backup dates for 
each file or Only most recent backup dates.

Show File Details

To view file details (for example, file size and write permissions), click Verbose display of 
attributes and file names on the View menu. To view filenames without details, click Brief 
display of file names (default).

Update the Display

To update the NetBackup window to show the most recent changes (such as file additions 
or deletions), click Update Display on the Edit menu.
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 5

This chapter describes the various windows, screens, and menus associated with the xbp 
and bp user interface programs. Much of the information in this chapter is also available 
in the online help for the interfaces. Refer to Chapter 4, “Using the X-Windows Interface,” 
or Chapter 3, “Using the Menu Interface,” for instructions on using the interfaces. For 
information on the Java interface, refer to Chapter 2, “Using the Java Interface,” or the 
online help for that application.
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Graphical User Interface (xbp)
The xbp program provides a graphical interface for NetBackup users. This interface is X 
Windows based and uses the OSF/Motif conventions. A general description of Motif 
usage is available in the OSF/Motif User’s Guide, authored by the Open Software 
Foundation and published by Prentice Hall (ISBN 0-13-640509-6). The following topics 
describe the windows, screens, and menus that you use to perform operations with xbp.

Special Symbols in Menus and Dialog Boxes

You will encounter the following symbols as you use the menus and dialog boxes:

◆ An ellipsis (...) to the right of a menu item means that when you select the item, a 
dialog box with additional choices appears. If there is no ellipsis in a menu item, the 
operation occurs as soon as you select it.

◆ A diamond shape to the left of a menu item means that two or more mutually 
exclusive modes exist and the mode set by this menu item is currently in effect. For 
example, if you intend to restore an archived file, you want the diamond to the left of 
Browse Archives (Restore).

◆ An underlined letter in a menu label means a keyboard shortcut. For example, on an 
NCD terminal, pressing ALT in conjunction with a shortcut key opens the associated 
menu. For example, pressing ALT-v opens the View menu. Note that some terminals 
may require a key other than ALT. 

◆ Once a menu is opened, a letter (by itself) is sufficient to execute a menu item tagged 
with that letter (pressing i on the View menu changes the Directory Structure pane 
format to indented. You can use the up and down arrow keys to move the highlight 
through the various menu items and press Enter to execute the highlighted item. The 
Escape key closes a menu. The left and right arrow keys open adjacent menus.

◆ If the pointer is over the main window, its shape changes to a wristwatch shape while 
NetBackup is waiting for an operation to complete. For example, the pointer changes 
to a wristwatch shape when NetBackup is updating its displays and then changes 
back to an arrow when the update is complete.

xbp Configuration

Borders on windows may vary depending on the window manager used at your site 
(popular examples are twm and mwm). With some window managers, you may have to 
click the left mouse button to position the window if it does not appear in a few seconds. 
You can also use your window manager to resize the window. 

The xbp program has enough space in its text fields to accommodate user-selected fonts 
up to the 10x20 size. The windows can also fit on a 1024x768 screen with some room for 
window manager borders.
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There is no default font. If the XNB resource file is in the X search path, xbp uses the 
values set in XNB. On some systems, the default font might be unpleasantly small. On 
other systems, the default font has proportional spacing, causing column misalignment 
on certain fields that have columnar text. 

For an explanation of how to specify X resources to force a particular font, look near the 
end of the Tutorial help files. For example

1. From the Help menu, click Tutorial. The Online Help Text for xbp dialog box will 
appear.

2. Scroll to the Customizing xbp section. 

If your X server defaults to proportional fonts and you do not know which fonts are 
available for your system, try the generic font name fixed.

Because the default window sizes are small enough to fit on a 1024x768 screen, you may 
find that with larger fonts, the verbose display mode forces you to use a horizontal 
scrollbar to see all the information. Widening the window at runtime with the window 
manager may eliminate the scrollbar. You can also change X resources as described in the 
Customizing xbp section of the Tutorial help file to enlarge the default geometry and use 
a smaller font. 

The xbp program depends upon the /usr/lib/X11/XKeysymDB file to correctly use 
editing keystrokes such as backspace and delete. The NetBackup installation procedures 
are designed to install a nominal version of this file if it does not already exist. An existing 
version of the file is not overwritten, thereby ensuring that user-customized versions of 
XKeysymDB are not destroyed.

Sun systems typically have a version of XKeysymDB that does not define some editing 
keys. Either you or the administrator must compare your current XKeysymDB file to the 
NetBackup standard version /usr/openv/netbackup/bin/XKeysymDB on 
NetBackup server machines. Then:

◆ Append the NetBackup version onto the existing one.

or

◆ Replace the existing one with the NetBackup version.

or

◆ Hand edit the existing version to achieve your preferred keyboard support.
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xbp_main Window

The xbp_main window opens when you start the graphical interface program.

You can pull menus from the menu bar to start backup, archive, and restore operations. 
The text boxes let you enter specific values for finding and selecting directories and files. 
The lists show information about selected directories and files.
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File Menu

The File menu has commands for inding and selecting files for NetBackup operations. You 
can also browse for and select database scripts

Note The following are not supported for BusinesServer: Auspex FastBackup, 
SQL-BackTrack, DB2, and SAP.

Browse File System 
(Backup or Archive)

Causes NetBackup to update its Directory Structure pane and the Files pane 
with directories and files that meet the criteria entered in the Directory To 
Search box, the Range of Dates boxes, the Filename Filter box, and the 
Keyword phrase to associate with this backup box.

Browse Backups 
(Restore)

Causes NetBackup to build a list of the backups that exist for this client. The 
completed list appears in a Backup Images pane that opens in the main 
window. 

Browse Backups 
(True Image 
Restore)

Causes NetBackup to build a list of the true-image backups that exist for this 
client. The completed list appears in a Backup Images pane that opens in the 
main window. 

Browse Archives 
(Restore)

Causes NetBackup to build a list of the archives that exist for this client. The 
completed list appears in a Backup Images pane that opens in the main 
window. 
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Edit Menu

The Edit menu has commands to modify your selections.

Browse backups 
(restore raw 
partitions)

Causes NetBackup to build a list of the raw partition backups that exist for 
this client. The completed list appears in a Backup Images pane that opens in 
the main window. 

Browse backups 
(Auspex 
FastBackup raw 
partition) 

Causes NetBackup to build a list of the Auspex FastBackup raw partition 
backups that exist for this client. The completed list appears in a Backup 
Images pane that opens in the main window.

Note: Auspex FastBackup is not supported for BusinesServer.

Browse File System 
for database 
extension

NetBackup offers database extensions that you can use, in conjunction with 
xbp, to back up and restore many of the most popular databases. These 
NetBackup for database extensions are separately priced products which 
must be installed, then configured to work with xbp. See the NetBackup for 
database extension system administrator guides for details.

The Browse File System commands enable the NetBackup for database 
extension. They cause NetBackup to update its Directory Structure pane and 
the Files pane to show all directories and files that meet the criteria of the 
Directory To Search box, the Range of Dates boxes, Filename Filter box, and 
the Keyword phrase to associate with this backup box.

Note: SQL-BackTrack, DB2, and SAP are not supported for BusinesServer.

Configuration Opens the xbp_config dialog box from which you can specify the master 
server, the client to browse for restores, the client to restore to, and the class 
type of images to browse. For more information, see “xbp_config Dialog Box” 
on page 118.

Quit Terminates the graphical interface program.

Clear Selection for 
Current Directory

Clears file selections from the Files pane. You must use Discard Selections for 
Previous Directories to clear the xbp_confirm dialog box.

Select All in Current 
Directory

Selects all the files in the Files pane.
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View Menu

The View menu has commands that modify how NetBackup shows directory and file 
information in the Directory Structure pane and the Files pane.

Discard Selections 
for Previous 
Directories

Clears file selections from the xbp_confirm dialog box.

Inspect All 
Selections

Opens the xbp_viewselect dialog box, which shows you the files that are 
currently selected. This dialog box has only information and no commands 
except to close the dialog box or to obtain help.

Update Display Rereads your directory tree and updates the Directory Structure pane and the 
Files pane. This is equivalent to pressing Enter in any of the text boxes.

Brief display of file 
names

Shows filenames without details. The display starts in brief mode.

Verbose display of 
attributes and file 
names

Shows file details such as size and file permissions.

Indented tree 
structure

Indents items in the Directory Structure pane to show the hierarchy of the 
directory tree. You can use either Indented tree structure or Full pathnames 
mode, but not both. The default is indented mode.

Full pathnames Shows full pathnames in the Directory Structure pane. You can use either Full 
pathnames or Indented tree structure mode (see above), but not both. The 
graphical interface starts in the indented mode.

All backup dates for 
each file

Shows all backups for each file in the Files pane. You can execute this 
command only when the File menu is set to one of the browse backups mode 
or archives modes (diamond shape to the left of those entries). The choice is 
unavailable when you browse the file system. The All backup dates for each 
file and Only most recent backup dates choices are mutually exclusive. You 
can use either but not both. The graphical interface starts in the All backup 
dates for each file mode.
Chapter 5, Reference Guide to xbp and bp 105



Graphical User Interface (xbp)
Backup Menu

The Backup menu has commands to start a backup or archive of selected files and 
directories. You can also obtain a progress report on backups or archives. The File menu 
must be set to a browse file system mode (diamond shape to the left of the command) 
before you can execute any Backup menu commands, other than the report on progress. If 
the graphical interface is in a restore mode, when you pull down the Backup menu, the 
backup commands are unavailable.

Note If you click Backup Selected Files and Directories or Archive Selected Files and 
Directories but then close the xbp_confirm dialog box without confirming your 
selections, you are returned to the main window. Your file selections, however, 

Only most recent 
backup dates

Shows only the most recent backup of a file in the Files pane. This command 
is useful if you lose a directory and want to get the most recent copy of all files 
(which may be spread across many backups). You can execute this command 
only when the File menu is set to one of the browse backups mode or archives 
modes (diamond shape to the left of those entries). The choice is unavailable 
when you are browsing the file system. The All backup dates for each file (see 
above) and Only most recent backup dates choices are mutually exclusive. 
You can use either but not both. The graphical interface starts in the All 
backup dates for each file mode.

Resolve Links in 
Search Directory

If you click this command, NetBackup automatically changes any links in 
your search path so the path points to the actual file or directory. This is the 
default.

Do Not Resolve 
Links in Search 
Directory

If you click this command, NetBackup searches for the path as you type it in, 
without resolving links.
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remain in the xbp_confirm dialog box. This feature is useful if you want to return to 
the main window to edit your selections. To clear previous file selections, click 
Discard Selections for Previous Directories on the Edit menu.

Backup Selected 
Files and Directories

Starts a backup of the current selections from the Files pane by opening the 
xbp_confirm dialog box. This dialog box shows the current selections. Click 
OK to execute the backup. Click Cancel to abort and return to the main 
window.

Backup Search 
Directory

Starts a backup of the current selection from the Directory Structure pane by 
opening the xbp_confirm dialog box. This dialog box shows the current 
selection.Click OK to execute the backup. Click Cancel to abort and return to 
the main window.

Backup Database 
Using Selected 
Scripts

NetBackup offers database extensions that you can use, in conjunction with 
xbp, to back up and restore many of the most popular databases. These 
NetBackup for database extensions are separately priced products which 
must be installed, then configured to work with xbp. See the NetBackup for 
database extension system administrator guides for details.

This command starts a backup of a database by opening the xbp_confirm 
dialog box. This dialog box shows the scripts you selected from the Files 
pane.Click OK to execute the backup. Click Cancel to abort and return to the 
main window.

Archive Selected 
Files and Directories

Starts an archive of the current selections from the Files pane by opening the 
xbp_confirm dialog box. This dialog box shows the current selections. Click 
OK to execute the backup. Click Cancel to abort and return to the main 
window.

Archive Search 
Directory

Starts an archive of the current selection from the Directory Structure pane 
by opening the xbp_confirm dialog box. This dialog box shows the current 
selection.Click OK to execute the backup. Click Cancel to abort and return to 
the main window.

Report Progress Of 
Backup

Opens the xbp_progress dialog box, which shows the log files pertaining to 
your backup operations. See “xbp_progress Dialog box” on page 121 for 
more information.

Report Progress Of 
Archive

Opens the xbp_progress dialog box, which shows the log files pertaining to 
your archive operations. See “xbp_progress Dialog box” on page 121 for 
more information.
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Restore Menu

The Restore menu has commands to start a restore of selected files and directories. You 
can also obtain a progress report on restores. The File menu must be set to a browse for 
restore mode (diamond shape to the left of the command) before you can execute any 
Restore menu commands, other than the report on progress. Otherwise, when you pull 
down the Restore menu, those choices are unavailable.

Note If you click Restore Selected Files and Directories but then close the xbp_confirm 
dialog box without confirming your selections, you are returned to the main 
window. Your file selections remain in the xbp_confirm dialog box. This feature is 
useful if you want to return to the main window to edit your selections. To clear 
those previous file selections, click Discard Selections for Previous Directories on 
the Edit menu.

Specify Alternate 
Path

Opens the xbp_altpath dialog box. This dialog box lets you restore files to a 
directory other than the one from which they were backed up. If you specify a 
path that does not exist, NetBackup creates it when restoring the file. (Note 
that DomainOS clients do not support alternate path restores.) Refer to 
“xbp_altpath Dialog Box” on page 119 for more details.

Restore Selected 
Files and 
Directories

In all browse modes except true-image restore, this command starts a restore 
of current selections in the Files pane. In true-image restore mode, this 
command starts a true-image restore of the selected directory. In both cases 
the xbp_confirm dialog box opens to show the current selections. Click OK to 
execute the backup. Click Cancel to abort and return to the main window.

Restore Search 
Directory

Not available in Browse backups (true image restore) mode, this command 
starts a restore of the current selection in the Directory Structure pane by 
opening the xbp_confirm dialog box. This dialog box shows the current 
selections. Click OK to execute the backup. Click Cancel to abort and return to 
the main window.
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Help Menu

The Help menu has online instructions for using the graphical interface.

Directory To Search Box

The directory to search is the starting point in a browse for files to back up, archive, or 
restore. The default is the directory you used to start the graphical interface. You can 
change the directory to search by typing a new directory path in the Directory To Search 
box and pressing Enter, or by double clicking on a directory in the Directory Structure 
pane.

When specifying the directory to search, you can also use the following wildcard 
characters

Restore Database 
Using Selected 
Script

NetBackup offers database extensions that you can use, in conjunction with 
xbp, to back up and restore many of the most popular databases. These 
NetBackup for database extensions are separately priced products which 
must be installed, then configured to work with xbp. See the NetBackup for 
database extension system administrator guides for details

These commands start a restore of their respective type of database by 
opening the xbp_confirm dialog box. This dialog box shows the scripts you 
selected from the Files pane. Click OK to execute the backup. Click Cancel to 
abort and return to the main window.

Report Progress Of 
Restore

Opens the xbp_progress dialog box, which shows the log files pertaining to 
your restore operations. See “xbp_progress Dialog box” on page 121 for more 
information.
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* ? [] 

For example:

/home/s* 
/home/.??* 
/home/[a-z]*

If you are backing up or restoring a file path that has a wildcard character used literally 
(that is, as a non-wildcard character), you must escape the wildcard using a backslash (\) 
character. For example, the following path uses brackets that are not being used as 
wildcards:

/home/abc/fun[ny]name

To back up or restore this file path, you must precede the brackets with backslashes as in

/home/abc/fun\[ny\]name

so NetBackup interprets the brackets literally.

The backslash acts as an escape character only when it precedes a wildcard as in the above 
example. This means that NetBackup normally interprets it literally and it is a legal 
character to use in pathnames.

The Directory To Search box automatically scrolls horizontally to allow entry of long 
pathnames. To view paths that do not fit in the window, a scroll bar allows you to scroll 
horizontally.

Range of Dates Boxes
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The Range of Dates boxes allow you to specify a date range for browsing and selecting 
files. The left box is start date and the right box is end date. 

◆ For a restore, you type a range of dates that includes the times when you suspect the 
desired backups or archives occurred.

◆ For a backup or archive, you type the range of dates that includes the times when the 
desired files were last modified.

The Directory Structure pane and the Files pane will show only files that meet the date 
range criteria. The administrator can change the initial browse default to show a smaller 
range of dates by using the INITIAL_BROWSE_SEARCH_LIMIT option in the server and 
client /usr/openv/netbackup/bp.conf files.

Browse Mode

When you start the graphical interface, it is in backup mode and the default date range is 
from 01/01/70 to the current date. You can change this range by typing new values with 
the keyboard and pressing Enter. In the United States, the format for:

◆ dates is month/day/year. For example: 

01/23/93.

◆ time is hours:minutes:seconds. Hours is expressed in terms of the 24 hour clock. For 
example: 

12 am is 00:00:00, 12 pm is 12:00:00, and 11:30 pm is 23:30:00. 

Leave the end date blank to search from the start date to the current date.

Restore Mode

When you switch from backup mode to restore mode, NetBackup normally changes the 
starting date so that it defaults to the most recent full backup. However, if you type a 
specific date just before changing modes, your specification is used.

If the client belongs to more than one class, the starting date defaults to the last full 
backup that occurred first. For example, assume that the client belongs to ClassW1 and 
ClassW2 and full backups occur for both of them. If the last full backup for ClassW1 
occurred before the one for ClassW2, then the display shows files ranging from the time of 
the ClassW1 full backup.
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Keyword phrase to associate with this backup Box

Specifies a keyword phrase that NetBackup will associate with the backup being created 
by a backup or archive operation. You can then restore the backup by specifying the 
keyword phrase.

You can use this option in place of or in combination with the other restore options in 
order to make it easier to restore your backups and archives. The following meta 
characters can be used to simplify the task of matching keywords or parts of keywords in 
the phrase:

*   - matches any string of characters.

?   - matches any single character.

[ ]  - matches one of the sequence of characters specified within the brackets.

[ - ] - matches one of the range of characters separated by the “-”.

The keyword phrase is a textual description of the backup that is a maximum of 128 
characters in length. All printable characters are permitted including space (“ “) and 
period (“.”). You must enclose the phrase in double quotes (“...”) or single quotes ( ‘...’) to 
avoid conflict with the UNIX shell.

The default keyword phrase is the null (empty) string.
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Backup Images Pane

The Backup Images pane opens within the main window when you execute Browse 
Backups (Restore), Browse Backups (True Image Restore), or Browse Archives (Restore) 
from the File menu. This pane shows the backups or archives for your client. You can 
search either all or some of the backups to find directories and files that meet the values in 
the Directory To Search box, the Range of Dates boxes, the Directory Depth box, Filename 
Filter box, and the Keyword phrase to associate with this backup box.

The list starts with the most recent backup or archive. The list contains the following 
information on each backup:

Backed Up Date and time at which the backup occurred.

Expires Date and time at which NetBackup expires the backup and removes it from 
the Backup Images pane.

Files Number of files in the backup.

KB Size of the backup in kilobytes.

Sched Type Shows the type of schedule as follows:

- Full Backup

- Incr Backup

- User Backup

- User Archive

Class Backup class that created the backup. The system administrator configures 
the class names, as explained in the NetBackup System Administrator’s Guide - 
UNIX or the NetBackup System Administrator’s Guide - Windows NT/2000. 
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The rules for selecting backups from the Backup Images pane are:

◆ Selecting a specific backup changes both dates to show the backed up time for the 
selected backup.

◆ Selecting a range of consecutive backups changes the date boxes to show the oldest 
and newest times in the selected range.

◆ Selecting another backup cancels previous selections. If the list is longer than the 
window, a vertical scroll bar appears along the right edge. 

When you are satisfied with your selections, move the pointer over one of the text boxes 
and press Enter. This updates the Directory Structure pane and the Files pane to show the 
directories and files that are in the selected backups and meet your Directory To Search 
criteria, the Range of Dates criteria, the Directory Depth criteria, Filename Filter criteria, 
and the Keyword phrase to associate with this backup criteria. 

Note There may be a noticeable delay before the update occurs because the client must 
obtain this information from the NetBackup master server.

Directory Depth Box

The Directory Depth box determines how deep to search the subdirectories of the current 
directory. It has no effect on the Files pane. Increment or decrement the depth by typing a 
new value with the keyboard and pressing Enter. The default is 2.

Keyword Shows the keyword typed by the user when the backup was initiated.
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Filename Filter Box

The Filename Filter box determines the files, of a selected directory, that NetBackup 
shows in the Files pane. When you start the graphical interface, the Filename Filter box 
has a value of * and the Files pane shows all files. You can change the filter to limit the files 
that NetBackup shows. In addition to specific file names, you can use the following types 
of expressions to filter filenames:

Asterisk (*) matches one or more characters. For example, a search for *_log matches all 
files that end with _log.

Question mark (?) matches a single character. For example, a search for log? matches the 
log1, log2, and log3 files.

Brackets ([]) specify any of the listed characters. For example, a search for prog[1-4] 
finds all five-character files that start with prog and end with a digit in the range 1 
through 4. 
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Directory Structure Pane and the Files Pane

These panes show the directories and files that you can select for NetBackup operations. 
Directories in the Files pane are followed by a slash. The contents of these panes depends 
on the browse mode.

For more information on browsing directory trees and selecting files, see “Finding and 
Selecting Files and Directories” on page 94.

Browse File System (Backup or Archive) Mode

If you are in Browse File System (Backup or Archive) mode, the panes show the 
directories and files in the filesystem that:

◆ Are in the Directory To Search box or in subdirectories below it in the client's 
directory tree (the Directory Depth box determines number of levels shown).

◆ Have modified dates within the time frame specified in the Range of Dates boxes.

◆ Are in the currently selected directory which match the value in the Filename Filter 
box. 

When you start the graphical interface, it is in the Browse File System (Backup or Archive) 
mode and shows all directories and files that reside under the directory from which you 
executed the xbp command.
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Browse Backups (Restore) or Browse Archives (Restore) Mode

If you are in Browse Backups (Restore) or Browse Archives (Restore) mode, the panes 
show the directories and files that are in the selected backups or archives and meet the 
following criteria:

◆ Are in the Directory To Search box or in subdirectories below it in the client’s 
directory tree (the Directory Depth box determines number of levels shown).

◆ Were backed up within the time frame specified by the Range of Dates boxes. 

◆ Are in the currently selected directory which match the value in the Filename Filter 
box.

Browse Backups (True Image Restore) Mode

If you are in Browse Backups (True Image Restore) mode, the panes show the directories 
that are in the selected backups and meet the following criteria:

◆ Are in the Directory To Search box or in subdirectories below it in the client’s 
directory tree (the Directory Depth box determines number of levels shown).

◆ Were backed up by a scheduled full or incremental backup within the time frame 
specified by the Range of Dates boxes. 

◆ Are in the currently selected directory which match the value in the Filename Filter 
box. 

Browse for Scripts Modes

When in the browse for scripts modes, the panes show the same type of information as 
when you browse the file system for backups or archives.

NetBackup offers database extensions that you can use, in conjunction with xbp, to back 
up and restore many of the most popular databases. These NetBackup for database 
extensions are separately priced products which must be installed, then configured to 
work with xbp. See the NetBackup for database extension system administrator guides 
for details

Browse backups (restore raw partitions) Mode

When in the browse backups (Restore Raw Partitions) mode, the panes show the same 
type of information as when you browse the file system for backups or archives.

Browse backups (Auspex FastBackup raw partition)  Mode

Note Auspex FastBackup is not supported for BusinesServer.
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When in the browse backups (Auspex FastBackup Raw Partitions) mode, the panes show 
the same type of information as when you browse the file system for backups or archives.

xbp_config Dialog Box

The xbp_config dialog box opens when you click Configuration on the File menu. 

The xbp_config dialog box lets users change the following values. Use the mouse and 
keyboard to make the desired changes. After completing your changes:

◆ Click OK to use the new values.

or

◆ Click Cancel to cancel the changes so the previous values are still used.

Server This is the current master server to which NetBackup sends backup and 
archive requests and also the server that has the backup you can browse for 
files to restore to your client. The master server is the first one listed under the 
SERVER option in the /usr/openv/netbackup/bp.conf file on the client. 
See the NetBackup System Administrator’s Guide - UNIX or the NetBackup 
System Administrator’s Guide - Windows NT/2000 for more information on 
the bp.conf file.

When you start the graphical interface, this box shows the default master 
server configured for your client. You can change the name of the master 
server. If you specify an invalid name or your client does not belong to a 
configured class on that server, you get an error message.
118 NetBackup User’s Guide - UNIX



Graphical User Interface (xbp)
xbp_altpath Dialog Box

The xbp_altpath dialog box opens when you click Specify Alternate Path on the Restore 
menu. This dialog box lets you set up a restore to a path other than the one from which 
files were originally backed up.

The text boxes at the top of the dialog box show the restore paths:

Client To Browse 
For Restores

Client whose backed up files you can currently browse. The administrator on 
the master server can change this name to that of another client and can grant 
you permission to do the same by making the necessary changes to the 
/usr/openv/netbackup/altnames file on the master server. 

When you start the graphical interface, this box shows the name of the client 
on which you are running as specified by the CLIENT_NAME parameter in 
the /usr/openv/netbackup/bp.conf file on the client. 

See the NetBackup System Administrator’s Guide - UNIX or the NetBackup 
System Administrator’s Guide - Windows NT/2000 for more information on 
the altnames file and the bp.conf file.

Client To Restore 
To

When you start the graphical interface, this field shows the name of the client 
on which you are running.

The administrator running the user interface on the master server can change 
this name in order to direct files to another client. This ability is not available 
to other users.

Class type of image 
to browse

Type of client to which you are restoring files when you restore to an alternate 
client.

The client type must match that in Client To Restore To box and the Client To 
Browse For Restores box. You cannot restore clients from one type to another.

Restore From Shows a full or partial pathname that NetBackup uses to find the 
files to restore.

Restore To Shows the path to which NetBackup restores the selected files.
Chapter 5, Reference Guide to xbp and bp 119



Graphical User Interface (xbp)
When you start the graphical interface, these paths are set to your current directory to 
search.

Use the mouse and keyboard to change the paths in the Restore From box and the 
Restore To box. You can use the Current Directory button to change the values in both 
boxes to their default, which is your current directory to search. If you specify a path that 
does not currently exist, NetBackup creates it when restoring the file. 

After completing your changes to the paths:

◆ Click OK to use the Restore From and Restore To paths on the next restore.

or

◆ Click Cancel to cancel the changes so the previous paths are still used.

You can also rename soft (symbolic) and hard links to the files so those links show the 
Restore To pathname:

xbp_confirm Dialog Box

The xbp_confirm dialog box opens when you execute a NetBackup operation. This dialog 
box shows the items you picked in the Directory Structure pane or Files pane and lets you 
confirm them before continuing. If the list of selections is longer than the dialog box, a 
vertical scroll bar appears along the right edge.

Rename Hard Links Enable the button to rename hard links so they point to the new path. The 
button is enabled when highlighted.

Rename Soft Links Enable the button to rename soft (symbolic) links so they point to the new 
path. The button is enabled when highlighted.
120 NetBackup User’s Guide - UNIX



Graphical User Interface (xbp)
Note Mount points inside will get restored whether or not the Restore directories without 
crossing mount points box is selected.

When you are satisfied with your selections, click OK to start the NetBackup operation. 

To cancel and return to the main window without performing a NetBackup operation, 
click Cancel. The cancel does not affect your selections. After cancelling, you can either 
edit your selections or clear them by clicking Discard Selections for Previous Directories 
on the Edit menu.

xbp_progress Dialog box

The xbp_progress dialog box opens when you execute a Report Progress Of Backup, 
Report Progress Of Archive, or Report Progress Of Restore from the appropriate menu. 
This dialog box shows the related progress log files in your home directory and lets you 
view them in order to monitor the progress of the operation. 

Use Log File The Use Log File checkbox lets you select whether you want NetBackup to 
create a progress log file in your home directory and write to this file as the 
operation progresses.

Enable the Use Log File checkbox to use the log file (this is the default). The 
name of the log file appears in the Log Filename box. Use report progress 
commands from the Backup menu or the Restore menu to read these files (see 
the next topic, “xbp_progress Dialog box” on page 121).

Overwrite Existing 
Files

If you are restoring files or directories, the Overwrite Existing Files checkbox 
lets you choose whether you want to overwrite existing files. 

Select the Overwrite Existing Files checkbox to overwrite. See “File 
Permissions Required By NetBackup” on page 6 for an explanation of how file 
ownership and permissions affect overwriting of files and directories.

Clear the Overwrite Existing Files checkbox if you do not want to overwrite 
existing files. The restore will not occur if the file exists.

Restore To 
Alternate Path

If you previously selected an alternate path, the Restore To Alternate Path 
checkbox is active and lets you restore files into a directory other than the one 
from which they were backed up (see “xbp_altpath Dialog Box” on page 119). 
If you did not previously select an alternate path, the checkbox is unavailable.

Select the Restore To Alternate Path checkbox to restore the files to the 
alternate directory.

Clear the Restore To Alternate Path checkbox to cancel the alternate path 
restore. 

Restore Directories 
Without Crossing 
Mount Points

To skip over file systems mounted in the selected directories, select the 
Restore Directories Without Crossing Mount Points checkbox (this is the 
default). 
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See “Checking Progress of Operations” on page 92 for information on using this dialog 
box.
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Menu Interface (bp)
The bp program is a menu driven user interface to NetBackup. When using the menus, 
you execute an operation by typing the letter to the left the related menu item. For 
example, typing B from the main menu takes you to the Backup menu (it is usually 
unnecessary to press Enter). An ellipsis (...) to the right of an option means that when you 
choose the option, another menu or screen appears from which you can make further 
choices. If there is no ellipsis, the operation occurs immediately.

Main Menu

Master Server Master server to which NetBackup sends operation requests. Use the M 
(Change Master Server) option from the Backup Menu or the Restore Menu to 
specify another master server.

Client Displays the name of the client for which the backup or archive will be 
performed.

B (Backup) Opens the Backup Menu.

R (Restore) Opens the Restore Menu.

H (Help) Help information for the main menu. Each secondary menu also has this 
option.

Q (Quit) Terminates the program and returns to the shell prompt.
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Backup Menu
 

Note The following menu items do not apply to BusinesServer: Backup SAP DB, Backup 
DB2 DB, and Backup SQL-BackTrack DB.

Master Server This is the master server to which NetBackup sends backup and restore 
requests. You can use the M (Change Master Server) option to specify another 
master server.

Client Displays the name for the client for which the backup or archive will be 
performed.

B (Backup Files and 
Directories)

Opens the Backup of Files and Directories menu.

A (Archive Files 
and Directories)

Opens the Archive of Files and Directories menu.

Backup database 
options

NetBackup offers database extensions that you can use, in conjunction with 
bp to back up and restore many of the most popular databases. These 
NetBackup for database extensions are separately priced products which 
must be installed. See the NetBackup for database extension system 
administrator guides for details.

O (Backup Oracle 
DB)

Opens the Backup Oracle DB menu.

I (Backup Informix 
DB)

Opens the Backup Informix DB menu.

S (Backup 
Sybase DB...)

Opens the Backup Sybase DB menu.

P (Backup SAP 
DB)

Opens the Backup SAP DB menu.

2 (Backup DB2 
DB)

Opens the Backup DB2 DB menu.
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Backup of Files and Directories Menu

T (Backup 
SQL-BackTrack 
DB)

Opens the Backup SQL-BackTrack DB menu.

M (Change Master 
Server)

Lets you change the master server to which NetBackup sends backup and 
restore requests. If it is an invalid server or the client does not belong to a 
user-directed backup class on that server, you receive an error message. The 
master server is set to the configured default for your client each time you 
start the menu interface.

H (Help) Help information for the Backup Menu. Each secondary menu also has a Help 
option.

Q (Quit Menu) Closes the Backup Menu and returns to the Main Menu.

Path This is the starting point for searches that you start with the S (Select Files and 
Directories)option. You can change the current directory with the P (Change 
Path) option from the menu. 

Start Date The Start Date and End Date (below) show the range of dates that the search 
will include. Start Date is the earliest modified date and time that a file can 
have for NetBackup to be included in the search.   You can change the Start 
Date with the D (Change Date Range) option from the menu. When you start 
the menu interface, theStart Date is set to 01/01/70 00:00:00 for backups and 
archives.

End Date The Start Date (above) and End Date show the range of dates that the search 
will include. End Date is the latest modified date and time that a file can have 
for NetBackup to be included in the search. You can change the End Date with 
the D (Change Date Range) option from the menu. When you start the menu 
interface, the End Date is set to 23:59:59 of the current day.
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Master Server This is the master server to which NetBackup sends NetBackup operation 
requests. You can use the M (Change Master Server) option to specify another 
master server.

Display Mode Displays the display mode, verbose or brief. Refer to “X (Change Display 
Mode to Verbose)” on page 126 for more details.

Files Selected Number of files currently selected for backup. This number changes as you 
select or deselect files with the S (Select Files and Directories)option or E 
(Edit/View Selected Files) option.

K (Change 
Keyword Phrase)

Displays the keyword phrase entered for the backup.

S (Select Files and 
Directories)

Displays the list of files and directories for the indicated path. Select files 
and/or directories from this list to back up.

E (Edit/View 
Selected Files...) 
option

Displays the list of files and directories previously selected for   backup. You 
can also add or delete selections from the list. For more information, see 
“Edit/View Selections Screen” on page 138.

I (Initiate Backup) Starts the backup operation. Selection I brings up prompts for creating a log 
file in your home directory and writing to this file as the operation proceeds.

P (Change Path) Lets you change the directory at which subsequent search operations begin. 

D (Change Date 
Range)

 Lets you change the Start Date and End Date as shown at the top of the menu. 
These dates specify the range in which a file's modification date must be in 
order to be included in the search for files to back up. Typing D brings up 
prompts for typing new start and end dates. 

Some basic rules for typing dates are as follows:

The format for dates is month/day/year. For example, 01/23/93.

The format for time is hours:minutes:seconds and in terms of the 24 hour 
clock. For example, 12 am is 00:00:00, 12 pm is 12:00:00, and 11:30 pm is 
23:30:00.

To leave a date unchanged, press Enter at the prompt.

If you change only part of the date or time and press Enter, NetBackup 
completes the entry.

M (Change Master 
Server)

Lets you change the master server to which NetBackup sends backup and 
restore requests. If an invalid server is selected, or the client does not belong 
to a user-directed backup class on that server, you will receive an error 
message. The master server is set to the configured default for your client each 
time you start the menu interface.

X (Change Display 
Mode to Verbose)

Selects whether the Search screen shows only names or also includes file 
details such as permissions. Toggle the Display Mode indication to Verbose 
for file details and to Brief to unselect them.

H (Help) Help information for the Backup of Files and Directories menu. Each 
secondary menu also has a Help option.
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Archive of Files and Directories Menu

The Archive of Files and Directories menu has choices for archive operations. Archive and 
backup operations are the same except that an archive deletes the file after backing it up, 
thus freeing disk space. 

The information at the top of the menu, as well as the menu choices, are the same as the 
Backup of Files and Directories menu. The one exception is the I (Initiate Archive) option 
which starts the archive operation.

Database Backup Menus

The database backup menus have choices for their respective types of database backups. 
The following figure is an example of the Backup Oracle DB menu.

Q (Quit Menu) Closes the Backup of Files and Directories menu and returns to the Main 
Menu.
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The information at the top of the menu, as well as the menu choices, are the same as the 
Backup of Files and Directories menu. The one exception is the I (Initiate Oracle DB 
Backup Using Selected Script(s)) option. Choosing this option uses the scripts you selected 
with the S (Select Scripts) option and E (Edit/View Selected Scripts) option to back up 
Oracle databases. The other Backup DB menus are the same, except for the menu choice 
that starts the backup. 

Refer to the appropriate NetBackup database System Administrator’s Guide.

Restore Menu
 

Note The following menu items do not apply to BusinesServer: Restore From Auspex 
FasBack Backups, Restore From SQL-BackTrack DB Backups, Restore From SAP DB 
Backups, and Restore From DB2 DB Backups.

Master Server This is the master server that has the backup for the files you are browsing. 
You can use the M (Change Master Server) option to select another master 
server.

Client Client that backed up the files you are permitted to browse and restore. 

B (Restore Files and 
Directories from 
Backups)

Opens the Restore Backups menu.

A (Restore FIles 
and Directories 
from Archives)

Opens the Restore Archives menu.

R (Restore From 
Raw Partitian 
Backups)

Opens the Restore Raw Partition Backups menu.
128 NetBackup User’s Guide - UNIX



Menu Interface (bp)
F (Restore From 
Auspex FastBack 
Backups)

Opens the Restore Auspex FastBackup Raw Partition Backups menu.

D (Restore From 
True Image 
Backups)

Opens the Restore True Image Backups menu.

Restore database 
options

NetBackup offers database extensions that you can use, in conjunction with 
bp to back up and restore many of the most popular databases. These 
NetBackup for database extensions are separately priced products which 
must be installed. See the NetBackup for database extension system 
administrator guides for details

O (Restore 
Oracle DB)

Opens the Restore Oracle DB menu.

I (Restore 
Informix DB)

Opens the Restore Informix DB menu.

S (Restore 
Sybase DB) 

Opens the Restore Sybase DB menu.

T (Restore 
SQL-Backtrack 
DB)

Opens the Restore DB using SQL-BackTrack menu.

P (Restore SAP 
DB)

Opens the Restore SAP DB menu.

2 (Restore DB2 
DB)

Opens the Restore DB2 DB menu.

M (Change Master 
Server)

Lets you change the master server to which NetBackup sends backup and 
restore requests. If it is an invalid server or the client does not belong to a 
user-directed backup class on that server, you receive an error message. The 
master server is set to the configured default for your client each time you 
start the menu interface.

H (Help) Help information for the Restore Menu. Each secondary menu also has a H 
(Help).

Q (Quit Menu) Closes the Restore Menu and returns to the Main Menu.
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Restore Backups Menu

Path This is the starting point for searches that you start with the S (Select Files and 
Directories). You can change the current directory with the P (Change Path) 
option from the menu.

Start Date Start Date and End Date (below) show the range of backup dates NetBackup 
searches for files to restore. Start Date is the earliest backup date and time that 
NetBackup checks when searching backups. You can change this with the D 
(Change Date Range) option from the menu.

End Date The Start Date (above) and End Date show the range of backup dates that 
NetBackup searches for files to restore. Start Date is the latest backup date 
and time that NetBackup checks when searching backups. You can change 
this with the D (Change Date Range) option from the menu.

Files Selected Number of files currently selected. This number changes as you select or 
deselect files with the S (Select Files and Directories) or E (Edit/View Selected 
Files) option.

Directory Depth This number indicates how many levels of directories and files NetBackup 
shows on the Search screen. You can increment or decrement the depth with 
the C (Change Directory Depth) option. The default is 1.

Display Mode Displays the display mode, verbose or brief. Refer to “X (Change Display 
Mode to Verbose)” on page 126 for more details.

Master Server Master server that has the backup for the files you are browsing. You can use 
the M (Change Master Server) option to select another master server.

Source Client Client that backed up the files you are permitted to browse and restore. You 
can use the B (Change Source Client) option to select another client.

Destination Client Client to which NetBackup will restore the selected files. This option will be 
displayed when you log in as root. Only the administrator on the master 
server can change this name to that of another client. See the T (Change 
Destination Client) option for information on changing this name.
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Class Type Your client type. This is Standard for all clients except those using the 
DomainOS operating system. DomainOS clients are Apollo_wbak.

See the Y (Change Client Type) option for information on changing the class 
type.

K (Change 
Keyword Phrase)

Displays the keyword phrase entered for the backup.

S (Select Files and 
Directories)

Takes you to the Search screen from which you can browse the backup. From 
this screen, you can select files and directories to restore.

E (Edit/View 
Selected Files)

Shows the list of files and directories previously selected for restore. You can 
also add or delete selections from the list.

I (Initiate Restore) Brings up the Initiate Restore screen from which you can start the operation. 
Typing an I brings up prompts for specifying whether:

◆ NetBackup creates a log file in your home directory and writes to   this 
file as the operation proceeds. 

◆ to overwrite existing files that have the same names as those you   are 
restoring.

If you selected A (Specify Alternate Path), you will be prompted to verify that 
you want to:

◆ restore to an alternative path

◆ rename hard links

◆ rename soft links

X (Change Display 
Mode to Verbose)

Selects whether the Search screen shows only names (Brief mode) or also 
includes file details such as permissions (Verbose mode). Toggle the Display 
Mode indication to Verbose to select file details and Brief to unselect them.

L (List Backup 
Images)

Lists the backups for the client that meet the Directory To Search, the Range 
of Dates, the Directory Depth box, Filename Filter, and the Keyword phrase to 
associate with this backup criteria.

A (Specify 
Alternate Path)

Lets you restore files to a directory other than the one from which they were 
backed up. If you specify a path that does not currently exist, NetBackup 
creates it when restoring the file. (DomainOS clients do not support alternate 
path restores.)

Q (Quit Menu) Closes the Restore Backups menu and returns to the Main Menu.

H (Help) Help information for the Restore Backups menu. Each secondary menu 
also has a H (Help) option.

P (Change Path) Lets you change the directory at which subsequent search operations begin. 
To find a specific file, type its complete pathname at the prompt. You can also 
use wildcard characters *, ?, [, and ] to find multiple files and directories. 

D (Change Date 
Range)

Lets you change the Start Date and End Date at the top of the menu. These 
dates specify the range of backup dates that NetBackup searches during a 
restore. Typing D brings up prompts for typing new start and end dates.
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C (Change 
Directory Depth)

Lets you change the number of levels of directories and files that appear on 
the Search screen. The new number appears in the Directory Depth field at the 
top of the screen. The default depth is 1. When restoring NetWare 
backups, set the directory depth to a minimum of 6 to ensure that the 
backup image is displayed.

M (Change Master 
Server)

Lets you specify the master server with the backup for the files you want to 
restore. If it is an invalid server or the client does not belong to a user-directed 
backup class on that server, you receive an error message. The master server 
is set to the configured default for your client each time you start the menu 
interface.

B (Change Source 
Client)

Lets the administrator on the master server browse and restore files for 
another client. The administrator can also change the configuration to give 
this ability to other users. When you start the menu interface this name is set 
to the default (normally the client on which you are running).

T (Change 
Destination Client)

Lets the administrator on the master server direct restored files to another 
client. When you start the menu interface, this name is set to the default 
(normally the client on which you are running).

Y (Change Client 
Type)

Lets the administrator on a server direct either standard client restores or 
Apollo_wbak restores. The class type must match that specified in the Source 
Client and Destination Client fields. You cannot restore files from one client 
type to another.

Note: The following class types do not apply to BusinesServer: Apollo-wbak, 
DataTools-SQL-BackTrack, Auspex-FastBackup, SAP, DB2, and FlashBackup.

K (Change 
Keyword Phrase)

Lets you enter a keyword phrase for your search.
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Restore Archives Menu

The Restore Archives menu is the same as the Restore Backups menu, except that you 
initiate the restore of archived files and directories.

Restore Raw Partition Backups Menu

The following figure shows the Restore Raw Partition Backups menu. You use the choices 
on this menu to select and initiate restores of raw partition backups (see “Restore Backups 
Menu” on page 130 for an explanation of the menu items).

Restore Auspex FastBackup Raw Partition Backups Menu

Note Auspex FastBackup is not supported for BusinesServer.
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The following figure shows the Restore Auspex FastBackup Raw Partition Backups menu. 
You use the choices on this menu to select and initiate restores of raw partition backups 
from Auspex FastBackup clients (see “Restore Backups Menu” on page 130 for an 
explanation of the menu items).

Restore True Image Backups Menu

Note NetBackup does not support true-image restores on DomainOS clients.

The following figure shows the Restore True Image Backups menu. You use the choices on 
this menu to select and initiate restores of true-image backups (see “Restore Backups 
Menu” on page 130 for an explanation of the menu items).
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Restore Database Menus

The Restore Menus for databases have choices for restoring their respective database 
backups. The following figure is an example of the Restore Oracle DB menu.

The information at the top of the menu and the menu options have the same meaning as 
the corresponding lines and options on the Restore Backups menu. The one exception is 
the I (Initiate Archive) option which starts the archive operation. 

When you choose the I (Initiate Oracle DB Backup Using Selected Script(s)) option, 
NetBackup uses the scripts you selected with the S (Select Scripts) option and the E 
(Edit/View Selected Scripts) option to restore Oracle databases. The other Restore DB 
menus are the same, except for the menu choice that starts the restore.

Refer to the appropriate NetBackup database System Administrator’s Guide for more 
information. 

Common Screens

The content of these screens varies depending on whether you are doing a backup, 
archive, or restore.
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Backup or Archive Search Screen

During a backup or archive, the Search screen appears when you choose the S (Select Files 
and Directories) option from the archive or backup menu. Use this screen to select 
directories and files for archive or backup.

Selections Number of files or directories previously selected. This number changes as 
you select or unselect files.

Current Path Current directory. This is the directory where currently displayed files and 
directories reside and is the highest level directory that you can currently 
show on the screen. Use Zoom(I)n or(Z)oomOut to move up or down in the 
directory tree from the current directory.

File List The file list shows directories and files that are in the current directory. The 
options at the bottom of the screen let you to browse the directory tree and to 
make selections (see “Search Screen Options” on page 137). 

Q  (not shown on screen) Type Q to exit without making any changes.
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Restore Search Screen

During restores, the Search screen appears when you choose the S (Select Files and 
Directories) option and NetBackup has completed its search for files and directories. Use 
this screen to select files and directories to restore.

The information fields on the top line have the same meanings as the Backup or Archive 
Search screen. The list shows the contents of the current directory at the time that the 
backup or archive occurred. 

◆ For a restore archive, the list contains files and directories from user-directed archives. 

◆ For a restore backup, the list contains files and directories from user-directed and 
administrator scheduled backups.

◆ For a true-image restore, the list contains only the directories from scheduled full and 
incremental backups. Files do not appear, nor do the results of user-directed backups 
or archives.

Type Q (not shown on screen) to exit without making any changes.

Search Screen Options

The options at the bottom of the Search screen let you browse the directory tree and make 
selections. Remember, as you do this, that it usually takes longer to search the backup 
than the file system (as is done during a backup or archive).

Execute an option by typing the letter in parentheses. For example, Z moves you up to the 
parent of the current directory. Type Q (not shown on screen) to exit without making 
changes. You can use either upper or lower case letters.

Zoom(I)n Moves you down one level in the tree to show the files and directories that are 
in the directory to which the arrow symbol currently points.
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Edit/View Selections Screen

The Edit/View Selections screen appears when you choose E (Edit/View Selected Files) 
option from a backup, archive, or restore (other than true-image) menu. This screen shows 
the directories and files that you have selected for backup, archive, or restore (depending 
on the operation you are performing). 

Note This screen is called View/Delete for true-image backups and restores and lets you 
delete but not add selections.

The top line on the screen shows the number of total selections. This number changes as 
you select or unselect files.

(Z)oomOut Moves you up one level in the tree to show the files and directories that are in 
the parent of the current directory.

(S)elect Selects the directory or file indicated by the current position of the pointer and 
adds an asterisk * to the left of the line. Pressing S again clears the item.

(B)ack Shows the previous screen of information.

(F)wd Shows the next screen of information.

(U)p Moves the pointer up one item in the list.

(D)n Moves the pointer down one item in the list.

(L)eft Shifts the display to the left, if you had previously shifted it to the right in 
order to show lines that are too wide for the screen.

(R)ight Shifts the display to the right in order to show lines that are too wide for the 
screen.

(O)k Retains your current selections and returns to the previous menu.
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The options at the bottom of the screen let you alter your selections. Select an option by 
typing the letter in parentheses. You can use either upper or lower case letters. For 
example, B shows the previous screen. Type Q (not shown on screen) to exit without 
making any changes.

View/Delete Selections Screen

The View/Delete Selections screen appears when you choose E (View/Delete Selected 
Files) from the Restore True Image Backups menu. This screen shows the directories you 
have selected for the true-image restore.

(A)dd Selection This option does not appear on the View/Delete screen for true-image 
restores. Lets you add a selection to the list. Choosing this option shows a 
dialog box in which you type the pathname of the file or directory you are 
adding. Pressing Enter adds the new selection to the list. 

If you add a selection for a restore, bp uses the range of dates determined by 
the current values of Start Date and End Date when searching for files. This 
provides some added versatility when searching for backups. For example, if 
you want to add a file that is outside the date range used for existing 
selections, you can exit to the restore screen, change the date range, then 
return to the Edit/View Selections screen and add the extra file.

You can also use wildcard characters *, ?, [, and ] to specify multiple files and 
directories.

Un(S)elect Unselects the directory or file to which the arrow symbol currently points and 
deletes it from the list.

(C)lear Clears all previous selections.

(B)ack Shows the previous screen of information.

(F)wd Shows the next screen of information.

(U)p Moves the pointer up one item in the list.

(D)n Moves the pointer down one item in the list.

(L)eft Shifts display to the left, if you had previously shifted it to the right in order to 
show lines that are too wide for the screen.

(R)ight Shifts the display to the right in order to show lines that are too wide for the 
screen.

(O)k Retains your current selections and returns you to the previous menu.
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System Administrators
 A

This section contains additional information on the jbp interface for the NetBackup 
Administrator.
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Alternate Client Restores
Alternate Client Restores
There are two types of alternate client restores, those that can be performed by the user, 
and those that can be performed by the system administrator.

User-Directed

Users can restore files to their client that were backed up by another client. The 
NetBackup Master server must be configured to allow alternate client restores, and the 
user must have authorization to perform the restore.

Server-Directed

Any administrator on any NetBackup server can direct a restore to the client that backed 
up the files. The administrator can also perform an alternate client restore—that is, files 
backed up from one NetBackup client can be restored to another NetBackup client, of the 
same type. Server-directed restores can be useful, for example, if users do not have 
permission to restore the files themselves.

Files or raw partitions can be restored to any client, of the same type, that backed up the 
files. It is not possible to perform a server directed restore through a database-extension 
product such as NetBackup for Oracle.

▼ To perform an alternate client restore

The following are general instructions for performing a server directed restore to a client. 

1. Log on as root to the UNIX master server that backed up the files.

2. Start the NetBackup-Java Backup, Archive, and Restore program.
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The NetBackup server text box shows the name of the UNIX master server on which 
you are currently operating.

3. Specify the following:

◆ NetBackup server

Specify the name of the NetBackup master server that backed up the files. This 
gives you access to the image catalog on that system so you can browse the 
desired backups.

◆ Source Client

Specify the name of the client that originally backed up the files. This allows 
browsing and restoring files backed up from that client.
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Alternate Client Restores
◆ Type of client

Specify a class type for the images that you are going to browse. This choice must 
match the type for the client that you are going to restore to (Destination client).

Note The Source and Destination client must always be the same type.

Refer to the following table for class settings for other clients.

◆ Destination client

Change the name in the Destination client box to the client where you want to 
direct the file.

Note The Destination client field is enabled only if the user is root or a non-root 
administrator and the machine jbp is connected to is a server. jbp determines this 
by chekcing the name of the machine jbp is connected to against the server list.

Table 3. Class Settings for Clients

Client Class

UNIX Standard

Macintosh Standard

Microsoft Windows 98 or 95 Standard

Microsoft Windows NT/2000 MS-Windows-NT

NetWare Target Standard

NetWare Non-Target NetWare

IBM OS/2 Warp OS/2
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Alternate Client Restores
The following example screen shows a restore of files that were backed up to eagle 
(NetBackup server) from spirea (source client) and are now being restored to an 
alternate client named mule (destination client). Both clients are standard.

4. Click Refresh to refresh the list of items available for restore.

5. Select the files or folders you want to restore.

6. Click Restore.
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Alternate Client Restores
The Restore Marked Files dialog box appears.

7. Select the desired options in the Restore Files dialog box and click Start Restore.

Note If you restore to a different location, the paths you enter in the Source and 
Destination boxes must use the formats specified in Table 4. Notice that a restore to 
a Windows NT/2000 client, requires UNIX conventions.

Table 4. Restore Path Formats

Client Path Format Example

UNIX /directory/ /usr/openv/netbackup/

Macintosh folder/folder/ NetBackup Admin/Configuration Files Dist/

Microsoft Windows 
NetWare Non-Target

/drive/directory/ /C/VERITAS/NetBackup/

NetWare Target /target/volume/data_path /MARGE/SYS/veritas/netbackup/

IBM OS/2 drive:\directory c:\veritas\netbackup
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Preventing Server Directed Restores

To prevent server directed restores, either add or delete settings on the client as shown in 
the following table.

Client Type Location of Setting To Prevent Server 
Directed Restores

Microsoft Windows 
NT/2000, 98, or 95

General tab in NetBackup Configuration dialog box on 
the client (click Configure on the Actions menu to 
display this dialog box)

Clear Allow server 
directed restores box

UNIX /usr/openv/netbackup/bin/bp.conf Add 
DISALLOW_SERVER_ 
FILE_WRITES

Macintosh /NetBackup Admin/Configuration Files 
Dist/bp.conf

Add 
DISALLOW_SERVER_ 
FILE_WRITES

NetWare 
(Target and Non-Target)

General tab in NetBackup Configuration dialog box on 
the client (click Configure on the Actions menu to 
display this dialog box)

Clear Allow server 
directed restores box

IBM OS/2 c:\veritas\netbackup\bp.ini Delete 
Allow_Server_
Write
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Restoring AFS Backups

Note AFS does not apply to BusinesServer.

This section notes the differences in the interface that the user will encounter when 
restoring backups from an AFS client.

All restores must be performed by the administrator either on the NetBackup for AFS 
client or the master server. The administrator can use the NetBackup client interface on 
the master server to restore volumes to the same or an alternate NetBackup for AFS client 
(AFS file server).

Restores are performed on the basis of volumes. To restore a vice partition, the 
administrator must select all the volumes in that partition.

Browsing and Marking Volumes/Vice Partitions

When browsing for AFS backups, you cannot use the Browse directory field to enter a 
specific path. Instead, select the vice partition you wish to view in the Directory Structure 
pane and its contents will be displayed in the right pane. 

Note The full path is not displayed in the Directory Structure pane. For example, 
/vicepa/user.abc is displayed instead of /AFS/eagle/vicepa/user.abc.

Restoring to Alternate Volumes/Vice Partitions

The jbp interface provides a convenient mechanism for specifying an alternate name for a 
volume and/or vice partition. Specifying an alternate volume name prevents an existing 
volume from being overwritten by the restore.

◆ If you do not specify Overwrite existing files or an alternate name for the volume, then 
NetBackup adds an “R” to the name of the restored volume as follows:

◆ If the volume name is less than 22 characters long, NetBackup adds a leading “R” 
to the name of the restored volume. For example:

If the volume name is: /vicepa/user.abc

The restored name is: /vicepa/Ruser.abc

◆ If the volume name is 22 characters long (maximum allowable length for a 
volume name), the first character of the original volume name is replaced with an 
R. For example:

If the volume name is: /vicepa/engineering.documents1

The restored name is: /vicepa/Rngineering.documents1
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Restoring AFS Backups
◆ If you are restoring to an alternate path and specify an existing volume, you must 
select Overwrite existing files for the restore to succeed. In this case, the entire volume 
is overwritten. If you do not select the Overwrite existing files option, the restore will 
fail.

◆ When restoring a volume to an alternate vice partition, the vice partition must exist or 
the restore will fail.
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Restoring Raw Partitions
A raw partition restore will restore a bit-by-bit backup of a partition of a disk drive on 
UNIX (on Windows NT/2000, this is called a disk-image backup). In order to restore a 
raw partition, you must have administrator capabilities on the master server or UNIX 
client. For further information on restoring FlashBackup raw partitions, refer to the 
NetBackup FlashBackup System Administrator’s Guide. For information on restoring Auspex 
FastBackup raw partitions, refer to the NetBackup System Administrator’s Guide - UNIX.

Note FlashBackup and Auspex FastBackup do not apply to BusinesServer.

Notes on Raw Partitions

◆ Ensure that the partition is not mounted and not in use (if the partition is being used 
by a database, make sure to shut down the database). The partition must be the same 
size as when it was backed up. Otherwise, the results of the restore are unpredictable.

◆ Ensure that the device file for the raw partition exists prior to the restore.

◆ The overwrite option is ignored during raw partition restores (except for Windows 
NT/2000 disk image restores). The device file must exist and the disk partition is 
overwritten whether this option is set or not. 

◆ When restoring a Windows NT/2000 disk image, the Overwrite existing files option 
must be selected in the Restore Files dialog.

◆ If you performed a raw-partition backup of a disk partition used for file systems, you 
must restore the entire partition to recover a single file. To avoid overwriting the 
entire partition, use the alternate-path restore feature to restore the raw partition to 
another raw partition of the same size, and then copy individual files to the original 
file system.

▼ To Restore an Entire Raw Partition

Note An entire raw partition can only be restored from a full backup. (NetBackup does 
not distinguish between full and incremental backups when performing a standard 
raw partition backup.)

1. Click on the Restore Files tab.

2. Select the Type of client you are using. For most clients this is “Standard.”

3. Select Raw partition from the Type of Backup drop-down list. 
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Restoring Raw Partitions
4. In the Browse directory specify the directory path to the device file, for example, 
/dev/rdsk/.

5. Click Refresh to refresh the list of raw partition backups available for restore.

6. In the right pane, select the device file.

7. Click Restore.

▼ To Restore Individual Directories or Files

Note In order to restore individual directories or files from a raw partition backup, the 
client must be in a FlashBackup or Auspex-FastBackup class and the server must be 
configured to allow for individual file restores from raw partition backups.

1. Click on the Restore Files tab.

2. Select Backup from the Source drop-down list.

3. In the Browse directory field, specify the path to the backed up file or folder you wish 
to restore.
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Restoring Raw Partitions
4. Click Refresh to refresh the list of backups available for restore.

5. In the right pane, select the desired files or folders.

6. Click Restore.

▼ To Restore a Windows NT/2000 Disk-Image Backup

1. Click on the Restore Files tab.

2. Select the Type of client you are using. For most clients this is “Standard.”

3. Click Refresh to refresh the list of items available for restore.

4. In the right pane, select the disk image, for example, \\.\c:.

5. Click Restore.

6. In the Restore Files dialog, be sure to select Overwrite existing files.
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Previewing Required Media
Previewing Required Media
The Preview Media Required allows you view a list of the media IDs which were used to 
backup or archive the selected files and directories. This feature is only available if your 
client is also a NetBackup server and if you have administrator capabilities. 

1. Click on the Restore Files tab.

2. Select the files and folders that you want to restore.

3. Click Preview Required Media.

4. Click Restore to begin the restore operation.
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access control list (ACL)

Security information associated with files on some file systems. 

ACS

Automated Cartridge System. This robot type is supported only by NetBackup 
DataCenter servers.

active job

A job for which NetBackup is currently processing backup or restore data.

activity logs

Logs that can be optionally enabled for specific NetBackup programs and processes and 
then used to investigate problems.

activity monitor

A NetBackup administration utility that displays information about NetBackup jobs and 
provides limited control over them.

administrator

A user that is granted special privileges to install, configure, and manage the operation of 
a system, network, or application

administration client

A Windows NT/2000 NetBackup client that has the administration interface software 
installed and can be used to administer NetBackup servers.

AIT

Sony Advanced Intelligent Tape, a type of tape drive or media type.
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alternate-client restore

Restoring files to your client when they were originally backed up from a different client. 
The administrator using the interface on the master server can direct a restore to any client 
(this variation is called a server directed restore).

alternate-target restore

On a Novell NetWare server platform running the NetBackup target version of client 
software, this operation restores files to a different target than the one from which they 
were backed up.

alternate path restore

Restores files to a different directory than the one from which they were backed up.

archive

A special kind of backup where NetBackup backs up the selected files, and if the backup 
is successful, deletes the files from the local disk. In this manual, references to backups 
also apply to the backup portion of archive operations except where otherwise noted.

archive bit

A file-status bit that the Microsoft based operating system sets when it writes a file, 
thereby indicating that the file has changed.

attributes for a class

Configuration parameters that control the behavior of NetBackup during operations 
involving this class.

automatic backup

A scheduled backup by the master server.

back up

The act of copying and saving files and folders to storage media.

backup

Refers to the process of copying and saving files and directories to storage media. For 
example, the backup is complete. This term can also refer to the collection of data that 
NetBackup saves for a client during a backup or archive. For example, duplicate the backup.

Backup is two words when used as a verb. For example, back up the file.
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backup, archive, and restore interface

The name of the NetBackup Microsoft Windows and Java based user interfaces for clients. 
On servers, these interfaces can be started through the NetBackup Administration 
interface.

backup window

The period of time during which backups can begin.

block size

The number of bytes in each block of data written on the media during a backup.

bp

A backup, archive, and restore utility for users on NetBackup UNIX clients. It has a 
character-based, menu interface that can be run from terminals that do not have X 
Windows capabilities.

bpadm

An administrator utility that runs on NetBackup UNIX servers. It has a character-based, 
menu interface that can be run from terminals that do not have X Windows capabilities.

bp.conf file

A NetBackup configuration file on UNIX servers and also on UNIX, Macintosh, and OS/2 
clients.

bp.ini file

NetBackup initialization file for Novell NetWare target clients.

bpcd

NetBackup Client service on Windows NT/2000 and the NetBackup Client daemon on 
UNIX. 

bprd

NetBackup Request Manager service on Windows NT/2000 and NetBackup Request 
daemon on UNIX.

catalogs

Internal NetBackup and Media Manager databases. These catalogs contain information 
about configuration, media, devices, status, errors, and the files and directories in the 
stored backup images.
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CDF

Context-dependent file, which is a type of directory structure on a Hewlett-Packard 
system.

class

Defines the backup policy for a group of one or more clients that have similar backup 
requirements.

client

The system with the files to back up, archive, or restore.

client-user interface

The program used to perform user backups, archives, and restores.

cluster

See master and media server cluster.

command lines

Commands that users can execute either from the system prompt or in scripts.

compression

The process of compacting data to enable more efficient transmission and storage.

configuration

The parameters that govern the behavior of an application. This term can also refer to the 
manner in which a network or system is laid out or connected (for example, a network 
configuration).

cpio

A UNIX command for formatting data on a tape.

ctime

The time that a UNIX inode was changed.

cumulative-incremental backup

A backup that is scheduled by the administrator on the master server and backs up files 
that have changed since the last successful full backup. All files are backed up if no prior 
backup has been done. Also see “differential-incremental backup.” 
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daemon

A program on a UNIX system that runs in the background and performs some task (for 
example, starting other programs when they are needed). Daemons are generally referred 
to as services or processes on Windows NT/2000 systems.

database-agent clients

Clients with additional NetBackup software that is designed to back up relational 
databases.

database-extension clients

See “database-agent clients.” 

debug logs

See “activity logs.” 

device delays

Delays caused by the device that are beyond the control of the storage application. An 
example is the time required to position tape under the read and write heads. 

device host

A Media Manager host where a drive or robotic control is attached or is defined.

device monitor

A Media Manager administration utility that provides monitoring and manual control of 
Media Manager storage devices. For example, an administrator or computer room 
operator can use this utility to manually reset devices or set them to the UP or DOWN 
state.

DHCP

Dynamic host configuration protocol. This TCP/IP protocol automatically assigns 
temporary IP addresses to hosts when they connect to the network.

differential-incremental backup

Scheduled by the administrator on the master server and backs up files that have changed 
since the last successful incremental or full backup. All files are backed up if no prior 
backup has been done. Also see “cumulative-incremental backup.” 

directory depth

The number of levels below the current directory level that the NetBackup interfaces 
show in their directory and file list displays.
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directory tree

The hierarchical structure in which files are organized on a disk. Each directory lists the 
files and directories that are directly below it in the tree. On UNIX, the topmost directory 
is called the root directory.

disaster recovery

Recovering data from backups after a disk crash or other catastrophe.

disk

Magnetic or optical disk storage media.

disk-image backup

A bit-by-bit rather than a file system backup of a disk drive on Windows NT/2000.

DLT

Digital-linear tape or tape drive type.

Domain Name Service (DNS)

A program that handles name translation for network communications.

drive cleaning

The use of a special cleaning tape to clean the heads on a drive.

duplicate image

A copy of a backup image.

encryption

Provides additional security by encrypting backup data on the client. This capability is 
available only with the NetBackup Encryption option.

entry and exit ports

A slot or other opening in a robot where you can insert or remove a tape without having 
to access the interior of the robot. After inserting a tape, you move it to a slot by using an 
inject command. Prior to removing a tape, you move it to the port by using an eject 
command. The inject and eject commands are supported through the add and move 
screens in the Media Manager administration interface. Entry and exit ports are 
sometimes called mailslots, or inports and outports.
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exclude list

A list that designates files or directories to exclude from automatic backups.

expiration (image)

The date and time when NetBackup stops tracking a backup image.

expiration (volume)

The date and time when the physical media (tape) is considered to be no longer usable.

EVSN

External volume serial number. This is an identifier written on a media cartridge or 
canister so the operator can identify the volume before inserting it into a drive or robot. 
For labeled media, the EVSN must be the same as the RVSN (identifier recorded on the 
media). For all media, the EVSN is the same as the media ID.

FastBackup

A special type of raw-partition backup that can be performed only on an Auspex client 
(this option is available only for NetBackup DataCenter).

FlashBackup

A special type of raw-partition backup that requires the NetBackup FlashBackup 
separately-priced option (this option is available only for NetBackup DataCenter).

flush level

Controls how often Netbackup clears its log files on a Novell NetWare or Microsoft 
Windows client platform.

fragment

A part of a backup or archive image. NetBackup can be configured to divide images into 
fragments when they exceed a certain size or span tapes.

frequency (backup)

How often NetBackup performs scheduled backups. For example, if the frequency is 
seven days then backups occur once a week.

FROZEN media state

If a volume is FROZEN, NetBackup keeps it indefinitely and can restore from it but not 
use it for further backups or archives.
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full backup

A backup that copies, to a storage unit, all files and directories that are beneath a specified 
directory.

FULL media state

If this appears in a report or listing, it indicates the volume is FULL and cannot hold more 
data or be used for further backups.

global attributes

NetBackup configuration attributes that affect all classes.

Global Data Manager

A separately-priced option (for UNIX servers) that provides an interface with a tree view 
where the administrator can view and administer multiple master servers. The server 
where the option is installed is called a Master of Masters.

GNU tar

A public domain version of the UNIX tar program.

goodies directory

A directory containing programs, scripts, and other files that are not formally supported.

gravity stacker

A robot that relies on gravity to advance to the next required tape.

GUI

Graphical user interface.

hard link 

On UNIX, a hard link is a pointer to the inode for the data. On Windows NT/2000 a hard 
link is a directory entry for a file. Every file can be considered to have at least one hard 
link. On NTFS volumes each file can have mulitple hard links, and a single file can appear 
in many directories (or even in the same directory with different names).

heap level

A parameter for memory-heap debugging on a Novell NetWare or Windows NetBackup 
client.
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hierarchical storage management

The process of automatically migrating selected files from a managed file system to 
specified migration levels on secondary storage, while maintaining transparent access to 
those files.

host

A computer that executes application programs.

host name

Name by which a host computer is identified by programs and other computers in the 
network.

HSM

See storage migrator.

image

The collection of data that NetBackup saves for an individual client during each backup or 
archive. The image contains all the files, directories, and catalog information associated 
with the backup or archive.

import

The process of recreating NetBackup records of images so the images can be restored.

include list

A list that designates files or directories to add back in from the exclude list.

incremental backup

See “cumulative-incremental backup” and “differential-incremental backup.” 

inport

See “entry and exit ports.” 

inode

A UNIX data structure that defines the existence of a single file.

install_path

Directory where NetBackup and Media Manager software is installed. The default on 
Windows NT/2000  is C:\Program Files\VERITAS and on UNIX it is /usr/openv.
Glossary 163



jbpSA

The Java-based NetBackup interface for performing user backups, archives, and restores.

jnbSA

The Java-based NetBackup interface for administrators.

job

A parcel of work submitted to a computer. NetBackup jobs are backups, archives, or 
restores.

kernel

The nucleus of an operating system.

keyword phrase

A textual description of a backup.

kill a job

Terminating a job and removing it from the job queue.

label

Identifier of a tape or optical disk volume. A recorded label includes a media ID.

A barcode label allows a barcode scanner to be used for media tracking.

library

Refers to a robot and its accompanying software. A library includes a collection of tapes or 
optical platters used for data storage and retrieval. For example, a Tape Library DLT 
(TLD) refers to a robot that has TLD robotic control.

link

See “hard link” or “symbolic link.” 

LMF - Library Management Facility

A Media Manager designation for a category of robot. For the specific vendor types and 
models in this category, see the VERITAS support web page at 
www.support.veritas.com. Choose NetBackup BusinesServer or NetBackup 
DataCenter in the VERITAS Support Product List and look under support options.

This robot type is supported only by NetBackup DataCenter servers.
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load

(noun) Amount of work that is being performed by a system or the level of traffic on a 
network. For example, network load affects performance.

(verb) Copy data to internal memory. For example, load the installation program.

logs

Files where a computer or application records information about its activities.

mailslot

See “entry and exit ports.” 

man pages

Online documentation provided with UNIX computer systems and applications.

Master and media server cluster

A NetBackup master server and the remote media servers that it is using for additional 
storage. It is possible to configure clusters only with NetBackup DataCenter servers. 
NetBackup BusinesServer supports only a single server, the master.

Master of Masters

A NetBackup host where Global Data Manager software is installed. When logging into 
this host, the interface has a tree view where the administrator can view and administer 
multiple master servers.

master server

The NetBackup server that provides administration and control for backups and restores 
for all clients and servers in a master and media server cluster. NetBackup BusinesServer 
supports only a single server and it is the master.

media

Physical magnetic tapes, optical disks, or magnetic disks where data are stored.

media host

NetBackup server to which the job (client) is sending the data.

media ID

An identifier that is written on a volume as part of the recorded label.
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Media Manager

Software that is part of NetBackup and manages the storage devices and removable 
media.

Media Manager Host

A host where Media Manager software is installed.

media server

A NetBackup server that provides storage within a master and media server cluster. The 
master can also be a media server. A media server that is not the master is called a remote 
media server (or slave server). NetBackup BusinesServer does not support remote media 
servers.

menu interface

A character-based interface for use on terminals that do not have graphical capabilities.

MHD

See “multihosted drives.” 

mount 

Make a volume available for reading or writing.

mount point

The point where a file system on a disk logically connects to a system’s directory structure 
so the file system is available to users and applications.

MPX

See “multiplexing.” 

mtime

The point in time when a UNIX or NTFS file is modified.

multihosted drives

A separately priced VERITAS option (Shared Storage Option or SSO) that allows tape 
drives (standalone or in a robotic library) to be dynamically shared among multiple 
NetBackup and Storage Migrator servers.

This option is supported only on NetBackup DataCenter servers.
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multiplexing

The process of sending concurrent-multiple backups from one or more clients to a single 
storage device and interleaving those images onto the media.

multiplexed group

A set of backups that were multiplexed together in a single multiplexing session.

NDMP

Network data management protocol. NetBackup requires the NetBackup for NDMP 
separately-priced option to support NDMP.

NetBackup Client service

NetBackup Windows NT/2000 service that runs on clients and servers and listens for 
connections from NetBackup servers and clients in the network. When a connection is 
made, this service starts the necessary programs.

NetBackup configuration options

On UNIX servers and on UNIX and Macintosh, clients, these settings are made in the 
bp.conf file. On NetWare target and OS/2 clients, they are in the bp.ini file. On 
Windows NT/2000 servers and Microsoft Windows clients, these settings are called 
properties and are made through the Backup, Archive, and Restore interface or the 
Configure - NetBackup window in the administration interface.

NetBackup databases

See catalogs. 

NetBackup Database Manager service

NetBackup Windows NT/2000 service that runs on the master server and manages the 
NetBackup internal databases (called catalogs). This service must be running on the 
master server during all NetBackup administrative operations.

NetBackup Device Manager service

The NetBackup Windows NT/2000 service that runs on a NetBackup server and starts the 
robotic control processes and controls the reservation and assignment of volumes. This 
service runs only if the server has devices under Media Manager control. The process is 
ltid.

NetBackup properties

Same as NetBackup configuration options but are called NetBackup properties on 
Microsoft Windows platforms.
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NetBackup Request Manager service

The NetBackup Windows NT/2000 service that runs on the master server and starts the 
scheduler and receives requests from clients.

NetBackup Volume Manager service

A NetBackup Windows NT/2000 service that runs on a NetBackup server, allows remote 
administration of Media Manager, and manages volume information. The process is vmd.

NIS

Network information service.

NLM

NetWare loadable module.

NFS

Network file system.

nonrobotic

See “standalone.” 

ODL

Optical disk library. This robot type is supported only by NetBackup DataCenter servers.

OSF and Motif

A set of specifications for user-interface design.

outport

See “entry and exit ports.” 

partitions

The logical partitions into which a magnetic disk is divided.

patch

A program that corrects a problem or adds a feature to an existing release of software.

path length

Number of characters in a pathname.
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pathname

The list of directories in the path to a destination directory or file.

PC clients

NetBackup clients that have Microsoft Windows (NT/2000, 98, 95), Macintosh, or IBM 
OS/2 operating systems.

peername

The name by which a computer identifies itself when establishing connections to other 
systems.

port

A location used for transferring data in or out of a computer.

primary copy

The copy of an image that NetBackup uses to satisfy restores. When NetBackup duplicates 
an image, the original is designated as the primary copy.

privileges

The tasks or functions that a user, system, or application is authorized to perform.

progress report

Log where NetBackup records events that occur during user operations.

proxy restore

A proxy restore allows the user to restore files, that he has write access to, on a machine 
other than his desktop. The files must be in a backup of the machine to which they are 
being restored.

QIC

Quarter-inch-cartridge tape.

queued job

A job that has been added to the list of jobs to be performed.

raw-partition backup

Bit-by-bit backup of a partition of a disk drive on UNIX. On Windows NT/2000, this is 
called a disk-image backup.
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rbak

The program that Apollo clients use to read data from tape during a restore.

registry

A Microsoft Windows 2000, NT, 98, and 95 database that has configuration information 
about hardware and user accounts.

remote media server

A media server that is not the master. Note that only NetBackup DataCenter supports 
remote media servers. NetBackup BusinesServer supports only a single server, the master.

residence

In Media Manager, information about the location of each volume is stored in a volume 
database. This residence entry contains information, such as robot number, robot host, 
robot type, and media type.

resource

A Novell NetWare term that refers to a data set on the target. For example, in DOS, 
resources are drives, directories, and files. Also see “target service.” 

restore

(verb) The act of restoring selected files and directories from a previous backup or archive 
and returning them to their original directory locations (or to an alternate directory).

(noun) The process of restoring selected files and directories from a previous backup and 
returning them to their original directory locations (or to an alternate directory).

retention level

An index number that corresponds to a user-defined retention period. There are 10 levels 
from which to choose (0 though 9) and the retention period associated with each is 
configurable. Also see “retention period.” 

retention period

The length of time that NetBackup keeps backup and archive images. The retention 
period is specified on the schedule.

root

The highest level directory in a hierarchical directory structure. In MS-DOS, the root 
directory on a drive is designated by a backslash (for example, the root on drive C is C:\). 
On UNIX, the root directory is designated by a slash (/).
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Also, a UNIX user name having administration capability.

RS-232

An industry-standard interface for serial communications and sometimes used for 
communicating with storage peripherals. 

RSM Interface

Application in Windows 2000 used to manage Removable Storage Manager (RSM) 
devices.

RSM - Removable Storage Manager

A Media Manager designation for a category of robot. For the specific vendor types and 
models in this category, see the VERITAS support web page at 
www.support.veritas.com. Choose NetBackup BusinesServer or NetBackup 
DataCenter in the VERITAS Support Product List and look under support options.

Also, a component of the Windows 2000 operating system that manages storage devices.

RVSN

Recorded volume serial number. This is an identifier recorded as part of the label on a 
volume and used by Media Manager to ensure that the correct volume is mounted. The 
RVSN is the same as the media ID.

schedules 

Controls when backups can occur in addition to other aspects of the backup, such as: the 
type of backup (full, incremental) and how long NetBackup retains the image.

SCSI

Small computer system interface. This is a type of parallel interface that is frequently used 
for communicating with storage peripherals.

slave server 

See Remote media server.

server directed restore

Using the client interface on the master server to restore files to any client. Only the 
administrator can perform this operation.

server independent restore

Restoring files by using a NetBackup server other than the one that was used to write the 
backup. This feature is available only with NetBackup DataCenter.
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server list

The list of servers that a NetBackup client or server refers to when establishing or 
verifying connections to NetBackup servers. On a Windows NT/2000 server and 
Microsoft Windows clients, you update the list through a dialog box in the interface. On a 
UNIX server and UNIX and Macintosh clients, the list is in the bp.conf file. On NetWare 
target and OS/2 clients, the list is in the bp.ini file.

service

A program on a Windows NT/2000 system that runs in the background and performs 
some task (for example, starting other programs when they are needed). Services are 
generally referred to as daemons on UNIX systems.

session

An instance of NetBackup checking its schedules for backups that are due, adding them to 
its worklist, and attempting to complete all jobs in the worklist. For user backups and 
archives, a session usually consists of a single backup or archive.

Shared Storage Option (SSO)

See “multihosted drives.” 

SMDR

Storage management data requestor, a Novell NetWare program that provides its services 
transparently to all SMS modules and lets remote and local modules communicate with 
one another.

SMS

Novell NetWare storage management services.

standalone

A qualifier used with drives and media to indicate they are not associated with a robot. 
For example, a standalone tape drive is one where you must manually find and insert 
tapes before using them. A standalone volume is one that is located in a standalone drive 
or is stored outside of a drive and designated as standalone in the volume configuration.

status code

A numerical code, usually accompanied by a message, that indicates the outcome of an 
operation.
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storage migrator

Refers to the VERITAS Storage Migrator line of hierarchical storage management products 
for UNIX and Windows NT/2000. These products make extra room on a disk by 
transparently moving data to other storage and then transparently retrieving the data 
when it is needed by a user or application.

Storage Migrator is available only for NetBackup DataCenter servers.

storage unit

Refers to a storage device where NetBackup or Storage Migrator stores files. It can be a set 
of drives in a robot or consist of one or more single tape drives that connect to the same 
host.

SUSPENDED media state

If a volume is SUSPENDED, NetBackup can restore from it but cannot use it for backups. 
NetBackup retains a record of the Media ID until the last backup image on the volume 
expires. 

symbolic link

On a UNIX system, this is a pointer to the name of the file that has the source data.

tape format

The format that an application uses to write data on a tape.

tape marks

A mark that is recorded between backup images on a tape.

tape overhead

The space required for data that is not part of the backup images. For example, tape marks 
and catalogs of what are on the tape are considered overhead.

tape spanning

Using more than one tape to store a single backup image.

tar

Tape ARchive program that NetBackup uses to extract backup images during a restore.

target

See “target service.” 
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target service

A Novell NetWare service that needs storage management. The SMS views all services (for 
example, print services, communication services, workstations) as targets.

Target Service Agent

A Target-service agent is a Novell NetWare agent that prepares the target’s data for SMS 
during a backup and for the target during a restore.

TLD - Tape Library DLT

A Media Manager designation for a category of robot. For the specific vendor types and 
models in this category, see the VERITAS support web page at 
www.support.veritas.com. Choose NetBackup BusinesServer or NetBackup 
DataCenter in the VERITAS Support Product List and look under support options.

TLH - Tape Library Half-inch

A Media Manager designation for a category of robot. For the specific vendor types and 
models in this category, see the VERITAS support web page at 
www.support.veritas.com. Choose NetBackup BusinesServer or NetBackup 
DataCenter in the VERITAS Support Product List and look under support options.

This robot type is supported only by NetBackup DataCenter servers.

TLM - Tape Library Multimedia

A Media Manager designation for a category of robot. For the specific vendor types and 
models in this category, see the VERITAS support web page at 
www.support.veritas.com. Choose NetBackup BusinesServer or NetBackup 
DataCenter in the VERITAS Support Product List and look under support options.

This robot type is supported only by NetBackup DataCenter servers.

TL4 - Tape Library 4MM

A Media Manager designation for a category of robot. For the specific vendor types and 
models in this category, see the VERITAS support web page at 
www.support.veritas.com. Choose NetBackup BusinesServer or NetBackup 
DataCenter in the VERITAS Support Product List and look under support options.

TL8 - Tape Library 8MM

A Media Manager designation for a category of robot. For the specific vendor types and 
models in this category, see the VERITAS support web page at 
www.support.veritas.com. Choose NetBackup BusinesServer or NetBackup 
DataCenter in the VERITAS Support Product List and look under support options.
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timeout period

The period of time that an application has allotted for an event to occur.

TIR

See “true image restore.” 

tpconfig

A Media Manager administration utility for configuring devices and is started from the 
command line. On UNIX, it has a character-based, menu interface that can be run from 
terminals that do not have X Windows capabilities.

transfer rate

The rate at which computer information is transferred between a source and a destination.

true image restore

Restores the contents of a directory to what it was at the time of any scheduled full or 
incremental backup. Previously deleted files are ignored.

TS8 - Tape Stacker 8MM

A Media Manager designation for a category of robot. For the specific vendor types and 
models in this category, see the VERITAS support web page at 
www.support.veritas.com. Choose NetBackup BusinesServer or NetBackup 
DataCenter in the VERITAS Support Product List and look under support options.

TSA

“Target Service Agent.” 

TSH - Tape Stacker Half-inch

A Media Manager designation for a category of robot. For the specific vendor types and 
models in this category, see the VERITAS support web page at 
www.support.veritas.com. Choose NetBackup BusinesServer or NetBackup 
DataCenter in the VERITAS Support Product List and look under support options.

This robot type is supported only by NetBackup DataCenter servers.

user operation

A backup, archive, or restore that is started by a person on a client system.

verbose flag

Configuration file entry that causes a higher level of detail to be written in the logs.
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verify

An operation that compares the list of files that are actually on a volume with what 
NetBackup has recorded as being on it. The data that is on the media is not verified.

vmadm

A Media Manager administrator utility for managing volumes. It runs on UNIX and has a 
character-based, menu interface that can be run from terminals that do not have X 
Windows capabilities.

vm.conf

A Media Manager configuration file with entries that include the servers that can manage 
local devices and default media ID prefixes for media that do not contain barcodes.

volume

Media Manager volumes are logical units of data storage or cleaning capability on media 
that have been assigned media IDs and other attributes, which are recorded in the Media 
Manager volume database.

volume configuration

Refers to configuration information that is stored in the Media Manager volume database.

volume database

An internal database where Media Manager keeps information about volumes. All Media 
Manager hosts have a volume database. However, the database is empty unless the host is 
designated as a volume database host.

volume database host

The Media Manager host that contains information about the volumes that Media 
Manager uses in a device. Because NetBackup BusinesServer supports only a single 
server, the volume database host is always the Media Manager host.

volume group

A set of volumes that are configured within Media Manager to reside at the same physical 
location (for example, in a specific robot).

volume pool

A set of volumes that are configured within Media Manager to be used by a single 
application and are protected from access by other applications and users.
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wakeup interval

The time interval at which NetBackup checks for backups that are due.

wbak

The program that Apollo clients use to write data on tape.

wildcard characters

A character that can be used to represent other characters in searches.

WORM media

Write-once, read-many media for optical disks. NetBackup BusinesServer does not 
support WORM media.

Windows Display Console

A NetBackup-Java interface program that runs on Windows 2000, NT, 98, and 95 
computers. Users and administrators can start this interface on their local system, connect 
to a UNIX system that has the NetBackup-Java software installed, and then perform any 
user and administrator operations that their permissions allow.

xbp

The X Windows-based backup, archive, and restore program for users on NetBackup 
UNIX clients. 

xbpadm

The X Windows-based NetBackup administration interface on UNIX. This interface is 
available only with NetBackup DataCenter.

xbpmon

The X Windows-based NetBackup utility for monitoring jobs on UNIX. This utility is 
available only with NetBackup DataCenter.

xdevadm

The X Windows-based Media Manager utility for managing devices on UNIX. This 
interface is available only with NetBackup DataCenter.

xvmadm

The X Windows-based Media Manager utility for managing media on UNIX. This 
interface is available only with NetBackup DataCenter.
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Index
A
Administrator

configure
automatic backups, 4
backup and archive windows, 4
browse default, 111
browse permissions, 119
class name, 113
destination client, 130, 132
source client, 132

directed restores, 5
exclude and include lists, 4
permission to browse other clients, 3
questions to ask the administrator, 6
scheduled backup, 137
server-directed restores, 132

AFS backups, restoring in jbp, 148
Agent, definition, 1
Alternate client restores

bp procedure, 65
definition, 156
jbp procedure, 142
Novell NetWare clients, 85
server directed, 5
xbp procedure, 85

alternate client restores, 5
Alternate path restore

bp
links in path, 62
procedure, 59
specify, 131

definition, 156
jbp, procedure, 36
Novell NetWare, 65
xbp, 121

procedure, 85
specify, 108

Alternate target restore

definition, 156
altnames file, 119
Archive bit

definition, 156
Archives

bp
Archive of files and directories, 127
initating, 127
of selected files/directories, 127
procedure, 48
progress log, 67
restoring, 133
search screen, 136

definition, 156
jbp

procedure, 21
restoring, 25

symbolic links, 5
UNIX write permissions required, 6
xbp

bplist, 94
browse all backups, 105
browse for restore, 103
browse recent, 106
listing, 83
procedure, 72
progress log, 92
report progress of option, 107
schedule type, 113
search directory, 107
selected files/directories option, 107
split across media id, 93

Auspex FastBackup
bp restore, 134
xbp restore, 104

Automatic backup, 4
Automatic refresh, xbp, 93
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B
Backup frequency

definition, 161
Backup images, definition, 163
Backup windows, 4

definition, 157
Backups

bp
backup menu, 124
database backup menus, 127
option, 123
procedure, 48
progress log, 67
search options, 136
search screen, 136

browse alternate client, 3
browse to restore, 103

Auspex Fastbackup, 104
raw partition, 104
true-image backups, 103

definition, 156
jbp, procedure, 19
scheduled, 4
symbolic links, 5
xbp

backup menu, 106
bplist command, 94
database script, 107
display, 97
filter by date, 95
images pane, 113
keyword phrase, 112
listing, 83
media IDs, 93
most recent, 106
procedure, 72
progress log, 92
report progress of, 107
schedule type, 113
search directory, 107
selected files/directories, 107
selecting a directory, 96
show all backups, 105
split across media id, 93

bp
alternate client restore, 65
backup SQL-BackTrack DB Backup 
option, 125
backup/archive procedure, 48

basic restore procedure, 53
progress logs, 67
resolving links, 67
restore SQL-BackTrack DB option, 129
starting, 48

bp.conf command
CLIENT_NAME option, 119
initial browse default, 111
mail notifications, 93

bp.conf file
definition, 157

bplist command, 94
Brief display

backup of files/directories menu, 126
change on backup files/directories 
menu, 126
change on Restore Backups menu, 131
Restore Backups menu, 130

Browse
backup images, 113
bp menu options, 51
class type of image, 119
directory depth, 114
directory structure, 116
directroy to search, 109
filename filter, 115
files, 116
keyword phrase, 112
mode, 111
range of dates, 111
search screen, 136
source client, 119, 130, 132
user interfaces, 3
xbp file menu, 103

C
CDE (Common Desktop Environment)

set up for NetBackup-Java, 11
CDF directories, 5
Client

alternate client, 5
bp

alternate client restore, 65
change destination client, 132
change source client, 132
destination client, 130
source client, 130

definition, 1
jbp, alternate client restore, 142
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xbp
alternate client restore, 85
client to browse for restore, 119
client to restore to, 119

Client user interface, 158
Clients, NetBackup

definition, 158
Commands

bp, 2, 48, 123
bp.conf, 93, 111, 118, 119
setenv, 70

Cross mount points
restore, 27, 82, 121

D
Database

backup database, 107
backup menu, 127
restore database, 109
restore menu, 135
script, 109
scripts, 103

Date
bp

change date range, backup, 126
change date range, restore, 131
end date, backup, 125
end date, restore, 130
start date, backup, 125
start date, restore, 130

jbp, selecting dates to restore, 32
xbp

date backup expires, 113
date backup occured, 113
filter by date, 95
range of dates, 111

xbp, selecting dates to restore, 87
Delete

bp
archive files/directories, 127
progress log files, 68

jbp
archive files/directories, 21
restore deleted files, 25

progress log files, 3
xbp

archive files/directories, 75
restore deleted files, 84

Directory

bp
change directory depth option, 132
change path option, 126, 131
directory depth, 130
path field, 50, 56
resolve links, 62
restoring true-image backups, 63
search, 56
selecting to backup, 51, 52
selecting to restore, 58

CDF, 5
jbp

resolving links, 42
restoring true image backups, 40

symbolic link, 5
UNIX permissions, 7
xbp

alternate path, 85
archive directroy structure pane 
selections, 107
backup directory structure pane 
selections, 107
deleting, 75
directory depth, 95, 96
directory depth box, 114
directory structure pane, 116
directory to search box, 109
discard selections, 105
display contents, 95
indented tree struction, 105
navigating the directory tree, 94
progress log file written to, 75, 82
resolving links, 91, 106
restore directory structure pane 
selections, 108
restore earlier version, 88
restore most recent version, 84
restoring true-image backups, 89
search, 79
selecting to backup, 73
selecting to restore, 78
show structure, 96
specify alternate path, 108
unselecting, 81
update display, 105
xbp_altpath dialog, 119

Disk partition, 5
bp, 60
jbp, 150
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xbp, 82
Disk-image backup

definition, 160
jbp restore, 150

Display mode
bp

backup of files/directories 
menu, 126
change, 126
restore menu, 130

bp change on restore menu, 131
font size, 101

Display update
edit menu, 105
restore procedure, 79

DISPLAY, setenv variable, 70
DLT, definition, 160

E
Exclude list, 4

F
FastBackup, see Auspex FastBackup, 134
File list

bp, 136
exclude and include lists, 4

File permissions, 6
Filename filter

description, 115
jbp, 17, 20
xbp, 95, 115

procedure, 80
Fonts, changing in xbp, 100

G
Graphical user interface

description, 100
using, 69

H
Help, online

bp help option, 123
specify X resources, 101
xbp, 69
xbp help menu, 109

HP (Hewlett Packard), restoring CDF 
directories, 5
HSM, 163

I
Include list, 5

install_path, 163
Interface

command line, 3
graphical, 2

description, 100
using, 69

java, 9
menu, 2

description, 123
using, 47

J
Java interface (jbp), 9

K
Keyboard shortcut, 100
Keyword phrase

bp
backup files/directories menu, 126
backup procedure, 51
Restore Backups menu, 131
restore files and directories 
menu, 132
restore procedure, 55

jbp
associating with backups, 20
using when restoring, 25

xbp
associating with backups, 112
backup procedure, 75
restore procedure, 80

L
Legal cahracter, 110
Library, definition, 164
Linked files

resolving links in bp, 67
resolving links in jbp, 42
resolving links in xbp, 91

Links, renaming pathnames, 39
Listing backups and archives

bp procedure, 55
bplist, 94
UNIX permissions, 7
xbp procedure, 83

Listing media id, 93

M
Mail notifications, 3, 6, 93
Master server

altnames, 119
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bp
backup menu, 124
backup of files/directories 
menu, 126
change for backup, 49, 125, 126
change for restore, 54, 129, 132
main menu, 123
name displayed, 48
Restore Backups menu, 130
restore menu, 128

directed restores, 5
exclude, include lists, 4
jbp

change for backup, 19
change for restore, 24

Novell NetWare client, 59, 65
xbp

cbp_config dialog, 118
change for backup, 72
change for restore, 76, 77
configuration, 104
current, 73

Maximum path length, 5
Media host, definition, 165
Media IDs, 93

listing in jbp, 153
Media Manager host

definition, 166
Media server

definition, 166
Menu interface, 2

description, 123
using, 47

Menus
bp

archive of files/directories, 127
backup, 124
backup database, 127
main, 123
restore, 128
restore archives, 133
restore Auspex FastBackup raw 
partition, 134
restore database, 135
restore raw partition backups, 133
restore true image backups, 134

xbp
backup, 106
edit, 104

file, 103
help, 109
restore, 108
view, 105

Mount points, 27, 82, 121
Mwm*keyboardFocusPolicy X resource, 12

N
NetBackup Client service

definition, 167
NetBackup configuration options

definition, 167
NetBackup Database Manager service

definition, 167
NetBackup Device Manager service

definition, 167
NetBackup Request Manager service

definition, 168
NetBackup Volume Manager service

definition, 168
NetWare Loadable Module, 168
NFS mounted files, 6
NLM (see NetWare Loadable Module)
Nonrobotic, definition, 168

O
Overwriting

bp
prompt, 131
raw partition restores, 60
restore procedure, 58
true-image restore, 65

CDF, 5
disk partition, 82
jbp

raw partition restores, 150
raw partition restores, 5
xbp

overwrite existing files 
checkbox, 121
procedure, 82

XKeysymDB, 101

P
Path

bp
alternate restore, 59
cancel alternate path restore, 61
change after a backup is intiated, 53, 
61
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change for a backup, 50
change for a restore, 56
change path option, 131
current path on search screen, 136
resolving links, 62, 67
specify alternate path, 131

jbp, resolving links, 23
maximum length, 5
xbp

alternate path, 87
directory to search box, 109
links, 79
navigating the directory tree, 94
restore to alternate path 
checkbox, 121
search path links, 106
specify alternate path, 108
xbp_altpath dialog, 119

Pathname
legal characters, 110
restore linked, 86
xbp, full pathnames, 105

Permission
bp file permissions for restore, 53
to browse backup on alternate client, 3
UNIX file permissions, 6
user-directed restore, 142
xbp

client to browse for restores, 119
client to restore to, 119
overwrite existing file, 82

Progress log
checking, 67
jbp, 29
xbp

creating, 121
deleting, 94
interpreting, 93
xbp_progress dialog, 92, 121

R
Range of dates boxes, 111
Raw partition

bp restore
device file, 54
mounted directory, 54
overwrite option, 60

jbp restore
device file, 150

mounted directory, 150
overwrite option, 150
procedure, 150

restore, overwrite option, 5
xbp restore

browse backups (Auspex 
FastBackup raw partiition), 104
browse backups (restore raw 
partitions), 104
device file, 76
mounted directory, 76

Raw partition backups
definition, 169

Refresh display
xbp, 97

if large number of backups 
shown, 79
update display on edit menu, 105

Remote media server
definition, 170

Resolving links
bp, 67
jbp, 42

wildcard characters, 42
xbp, 91

do not resolve links in search 
directory, 106
resolve links in search directory, 106
wildcard characters, 92

Resource (also see Target service), 170
Restore

bp
option, 123
procedure, 53
restore archives menu, 133
restore database menu, 135
restore menu, 128
restore raw partition backups 
menu, 133
restore search options, 137
restore true image backups 
menu, 134
true image, 63

CDF directories, 5
jbp

AFS backups, 148
alternate client, 142
alternate path, 36
archives, 25
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procedure, 24
raw partitions, 150
resolving links, 23
search option, 31
specific date range, 32
true image, 40

xbp
alternate client, 119
Auspex FastBackup, 104
browse archives, 103
browse backups, 103
brwse true-image backups, 103
client to browse for restore, 119
client to restore to, 119
deleted files, 84
directores without cross mount 
points, 121
mode, 111
procedure, 76
progress log, 92
raw partitions, 76, 104
report progress, 109
resolving links, 79
restore menu, 108
restore to alternate path, 121
selected files/diresctories, 108
specific date range, 87
true image, 89

Restore Auspex FastBackup raw partition 
backups menu, 134
Restores

definition, 170
server directed, 142
server directed to another client, 5

Retention period, 6
definition, 170

root, 170

S
Schedule

types, 113
Scheduled backups

administrator scheduled backup, 137
exclude list, 4
for automatic backup, 6
include list, 5

Search directory, in xbp, 108
Search screen

bp

backup or archive, 136
options, 137
restore, 137

Selections screen
edit/view, 138
view/delete, 139

Server directed restore, 142
definition, 171

server directed restores, 5
Session, NetBackup, 172
setenv command, 70
SMS (see Storage Management Services)
Special symbols in xbp, 100
Standalone

definition, 172
Status codes in xbp, 93
Storage Management Services, 172
Storage Migrator, 173
Storage units

definition, 173

T
Target Service, 174
Time Zone, adjusting in jbp, 13
tpconfig, definition, 175
True image restore

bp
menu, 134
procedure, 63
view/delete selections screen, 139

definition, 175
jbp, 40
xbp

browse backups, 103
procedure, 90

U
User-directed operations, 2

V
Verbose display

backup of files/directories menu, 126
change on backup files/directories 
menu, 126
change on Restore Backups menu, 131
Restore Backups menu, 130

vm.conf file
definition, 176

vmadm, definition, 176
Volume database host
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definition, 176
Volume database, definition, 176
Volume group

definition, 176
Volume pool

definition, 176

W
Wildcard characters

bp change path option, 131
jbp

filtering files, 17
in links, 42

xbp
links, 92
search, 109

Windows, for user-directed operations, 4
WORM media

definition, 177
Write permissions, viewing in xbp, 97

X
X resources, changing, 101
xbp

alternate client restore procedure, 85
backup/archive procedure, 72
basic restore procedure, 76
progress logs, 92
starting, 70
true-image restore procedure, 90
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